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Introduction

Welcome to the Octane workstation! The Octane Workstation Owner’s Guide is your
complete guide to installing, diagnosing, and repairing your Octane workstation.
Specifically it tells you how to

• set up your Octane workstation and turn it on

• access online hardware movies and information in Octane Hardware Central

• install and remove internal parts

• install and remove peripherals

• install and remove software

• diagnose hardware problems

• order replacement parts

This guide also provides:

• regulatory information

• technical specifications

Audience

This book is intended for the use of any Octane workstation user or technical support
person. Most of the hardware tasks are relatively simple and no prior computer
hardware knowledge is necessary. A few tasks are lengthy, and are more easily
performed by users who have some hardware experience. References are provided to
other appropriate documentation.
xxi



Introduction
Hardware Options

A listing of available Octane hardware configurations (upgrades and options) is
available on the Web. In the location window, type http://www.sgi.com/octane/.

Software and System Administration Information

For complete information on installing software, see the online Personal System
Administration Guide. It is located on your desktop in the Toolchest > Help> Online
Books. For more advanced information, see the online IRIX Admin: Software Installation &
Licensing Guide. For system administration information, see the SGI_Admin section of
the online bookshelf.

It’s always a good idea to back up your system. For instructions on backing up your
system, see the online Personal System Administration Guide.

Product Support

The Octane workstation is designed so that you may maintain and repair the workstation
without the help of a trained technician. Contact your SGI subsidiary or authorized
distributor for information about product support.

SGI provides a comprehensive range of product support for its products. If you are in
North America and would like support for your SGI-supported products, contact the
Technical Assistance Center at 1-800-800-4SGI or your authorized service provider. If you
are outside North America, contact the SGI subsidiary or authorized distributor in your
country.
xxii



This chapter explains how to set up your Octane workstation and attach it to
a network, turn the system on, and log in. It also explains how to use the IRIX
Interactive Desktop  environment.

Getting Started

Chapter 1





Chapter 1

1. Getting Started

This chapter tells you how to set up your Octane workstation. The following topics are
covered

• “Getting Acquainted” on page 3

• “Lifting the Octane Workstation” on page 8

• “Installing Optional Parts” on page 9

• “Setting Up the Octane Workstation” on page 10

• “Locking the Octane Workstation” on page 21

• “Logging Into the Octane Workstation” on page 24

• “Using the IRIX Interactive Desktop” on page 25

• “Shutting Down and Powering Off the Octane Workstation” on page 29

Getting Acquainted

To become familiar with the Octane workstation, see

• “Front View” on page 5, “Back View” on page 6, and “Checking Your Shipment” on
page 7.

• Octane Hardware Central is an online information resource containing movies, user
tips, technical information, cable pinouts, human factors guidelines, and so on.
Access Octane Hardware Central:

– Through Netscape: In the location window enter
file:/usr/share/Insight/library/SGI_bookshelves/SGI_EndUser/books

/Octane_HWCntl/index.html

– IRIX 6.5 users. From the Toolchest > Help >InfoSearch, type OCTANE Hardware

Central. (Do not choose “Online Books”; this book is not accessible from the
Online Books path.)

– IRIX 6.4 users: From the Toolchest > Help > Online Books > SGI End User,
choose Octane Hardware Central.
3



Chapter 1: Getting Started
If this reference guide is no longer installed on your system disk, follow these
instructions to install it:

Go to the Toolchest > System > Software Manager. Place the IRIX Foundation CD in
a CD-ROM or access it over the network. From the Toolchest > System choose
Software Manager. Press and hold the Lookup button and select IRIX Foundation
CD. Click Custom Installation. Select “IRIX Executive Foundation 6.4 for Origin,
Onyx2 and Octane.” Click on the arrow icon beside the word Product to access this
subdirectory. When you locate Octane Hardware Central, click on the box to the left of
the arrow icon. A red check mark appears. Click the Software Manager Start button.
When the installation is complete, a window appears “Installation and removals
were successful. You may continue with installation or quit now.” Click the OK
button in this window. Go to the File menu > Exit, and exit Software Manager.

Use either of the paths described earlier in this section to access Octane Hardware
Central.

• “About This System,” found in the Toolchest > System > System Manager for your
system serial number, IP address, operating system, and so on.

• System Manager > Toolchest > System > System Manager for information on
software and hardware installed on the Octane workstation.
4



Front View
Front View

Figure 1-1 Front View of the Octane Workstation
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Chapter 1: Getting Started
Back View

Figure 1-2 Back View of the Octane Workstation
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Checking Your Shipment
Checking Your Shipment

Figure 1-3 Octane Shipment Components
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Chapter 1: Getting Started
Lifting the Octane Workstation

Figure 1-4 Lifting the Octane Workstation

Lifting the Octane workstation is a two-person job. Lift the workstation by the air vents
at the top of the chassis, as shown in figure Figure 1-4.
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Organizing Your Setup Process
Organizing Your Setup Process

If you have no additional parts, memory, or peripherals to install, use the setup poster or
the setup steps in this chapter to set up the Octane workstation.

Install optional parts or peripherals before you follow the setup steps so that you will not
have to remove and reinstall cables.

Installing Optional Parts

• To install additional memory, see Chapter 2, “Installing and Removing the CPU and
Memory.”

• To install PCI Boards and the PCI module, see Chapter 4, “Installing and Removing
PCI Boards.”

• To install XIO Option Boards, see the option board installation manual that ships
with the XIO option board, or Chapter 5, “Installing and Removing XIO Graphics
and Option Boards.”

• To install external Peripherals or devices, see Chapter 6, “Installing and Removing
External Devices,” which includes

– SCSI devices

– serial devices

– audio devices

• To install drives (internal peripherals), see Chapter 7, “Installing and Removing
Drives and Front Module Parts.”

Use the setup poster or go to “Setting Up the Octane Workstation” on page 10 after you
have finished installing optional parts.
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Chapter 1: Getting Started
Setting Up the Octane Workstation

Human factors guidelines for setting up your Octane workstation are in Octane Hardware
Central, found online through the Toolchest > Help > Online Books > SGI End User.

To set up the Octane workstation, follow these steps:

Figure 1-5 Attaching the Keyboard and Mouse Cables

1. Attach the keyboard and mouse to the Octane workstation.

Mouse

Keyboard
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Setting Up the Octane Workstation
Figure 1-6 Attaching the Ethernet Cable

2. Attach the Ethernet cable to the Ethernet port on the Octane workstation.

Ethernet
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Chapter 1: Getting Started
Figure 1-7 Attaching the Speaker-to-Speaker Cable

3. Place the speakers on either side of the monitor as shown in Figure 1-7.

4. Connect the left (passive) speaker to the right (active) speaker. Use the port
labeled L.

Left (passive) speaker

Right (active) speaker

Power
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Setting Up the Octane Workstation
Figure 1-8 Attaching the Speaker and Power Cable to the Active Speaker

5. Connect the speaker/workstation cables (the cable with two connectors on each
end) to the active speaker. The connectors cannot be installed incorrectly because
they are different sizes; male/male on one end, female/male on the other.

■ Connect the female connector to the power (middle) port on the back of the
right (active) speaker.

■ Connect its paired male connector to the R port on the back of the right (active)
speaker.

Right (active) speaker

Power

To speaker port
on workstation

To left speaker

Power

Speakers
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Chapter 1: Getting Started
Figure 1-9 Connecting the Speaker and Power Cables

6. Connect the active speaker to the Octane workstation, using the cable with two
male connectors on the end.

■ Connect the smaller male connector to the speaker power port.

■ Attach the larger male connector to the speaker port.

speaker

power
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Setting Up the Octane Workstation
Figure 1-10 Attaching the Microphone

7. Set up the microphone.

■ Place the microphone cord through the slot in the base.

■ Slide the microphone back until it is firmly connected to the base.

■ Place the microphone in the center of the top of the monitor.

■ Place the cable over the back of the monitor.

■ Attach the cable to the microphone port on the Octane workstation.

Microphone
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Chapter 1: Getting Started
Figure 1-11 Connecting the Monitor and Power Cables

8. Connect the monitor and power cables.

■ Connect the monitor-to-graphics cable to the monitor. (Step A)

■ Connect the monitor-to-graphics cable to the I/O connector on the back of the
Octane workstation. (Step B)

■ Connect the monitor power cord to the monitor. (Step C)

■ Connect the Octane power cord to the back of the Octane workstation. (Step D)

B

A

C

D
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Setting Up the Octane Workstation
Figure 1-12 Connecting the Monitor and Power Cables to an Electrical Outlet

9. Connect the power cords from the Octane workstation and the monitor to an
electrical outlet.
17



Chapter 1: Getting Started
Figure 1-13 Powering On the Monitor

10. Press the power button on the monitor.
18



Setting Up the Octane Workstation
Figure 1-14 Powering On the Speakers

11. Press the power button on the active speaker.
19



Chapter 1: Getting Started
Figure 1-15 Powering On the Octane Workstation

If you are installing the lockbar, go to “Locking the Octane Workstation” on page 21.

If you are not installing the lockbar, go to step 12.

12. Press the power button on the Octane workstation.

You have just finished setting up the Octane workstation and are ready to login. See
“Logging Into the Octane Workstation” on page 24.

Power button
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Locking the Octane Workstation
Locking the Octane Workstation

Using the lockbar locks the bezel and system module to the chassis. Locking the bezel
prevents the option and system drives from being removed. Locking the system module
prevents the memory (DIMMs) and processor (CPU) from being removed.

The lockbar slot is found behind the door on the front of the Octane workstation.

Figure 1-16 Locating the Lockbar Slot

1. Open the door of the Octane workstation.

2. Locate the lockbar slot as shown in Figure 1-16.

Lockbar slot
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Chapter 1: Getting Started
Figure 1-17 Inserting the Lockbar

3. Slide in the lockbar. (Step A)

4. Secure it with a lock. (Step B)

5. Close the door.

Push inA

B
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Locking the Octane Workstation
Figure 1-18 Powering On the Octane Workstation

6. Power on the Octane workstation.

7. You have finished setting up the Octane workstation and are ready to log in.

Power button
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Chapter 1: Getting Started
Logging Into the Octane Workstation

Once you create a user login account for yourself and set up networking software, your
system is ready to create a personal work area for you and let you communicate with
other systems and people on your network.

If this is the first time your system is being booted, you see a login screen similar to the
one shown in Figure 1-19.

Figure 1-19 Login Screen

If you already have a login account, you see an icon with your login name. Double-click
the icon.

If you do not have a login account, double-click EZsetup and follow the instructions for
setting up your account and networking software.
24



Using the IRIX Interactive Desktop
Using the IRIX Interactive Desktop

Now you are ready to use the desktop management system called the IRIX Interactive
Desktop.

The IRIX Interactive Desktop and Its Icons

By default, several icons appear on the desktop: a folder icon representing your home
directory, a dumpster icon, and icons for peripherals you have installed. See Figure 1-20.

The peripheral icons show the current state of the devices they represent. For example, if
you place a music CD into the compact disc player, the icon changes. When you
double-click the icon, it opens CD Player, a utility that lets you play from a compact disc.

Figure 1-20 Peripheral Icons
25



Chapter 1: Getting Started
The Toolchest

The toolchest in the top left-hand corner of the screen (shown in Figure 1-21) provides
access to system functions, applications, and documentation.

Figure 1-21 Toolchest Icon

• Under the Toolchest > System is the System Manager, which provides hardware and
software information about your workstation.

• From the Toolchest > Help, you can access the library of online documentation.

For more information on the Toolchest, see the online Desktop User’s Guide, found in
the Toolchest > Help

– IRIX 6.5 users: InfoSearch, and type Desktop Users Guide.

– IRIX 6.4 users: Online Books > SGI End User > Desktop User’s Guide.

Documentation and Information Sources

This printed owner’s guide contains all the information you need when your
workstation is turned off and you cannot access online documentation. It is also found
on the Web in the Technical Publications Library.

Octane Hardware Central, an online hardware reference guide, is found online (for IRIX
6.5 users) through the Toolchest > Help > InfoSearch, by typing Octane Hardware Central.
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Using the IRIX Interactive Desktop
For IRIX 6.4 users, it is also found online through the Toolchest > Selected > File
QuickFind. Type insight in the window that appears. When the InSight bookshelf
appears, choose SGI End User > Octane Hardware Central, or you can open Netscape and
enter the following URL in the location window:

file:/usr/share/Insight/library/SGI_bookshelves/SGI_EndUser/books/
Octane_HWCntl/index.html

Octane Hardware Central is also found in the Technical Publications Library through
Search and Catalog. If it is no longer installed on your system disk, follow these
instructions to install it:

1. Go to the Toolchest > System > Software Manager. Place the IRIX Foundation CD in
a CD-ROM or access it over the network.

2. From the Toolchest > System, choose Software Manager.

3. Press and hold the Lookup button and select IRIX Foundation CD.

4. Click Custom Installation.

5. Select “IRIX Executive Foundation 6.4 for Origin, Onyx2 and Octane.”

6. Click on the arrow icon beside the word Product to access this subdirectory.

7. When you locate Octane Hardware Central, click on the box to the left of the arrow
icon. A red check mark appears.

8. Click the Software Manager Start button. When the installation is complete, a
window appearswith the message Installation and removals were
successful. You may continue with installation or quit now.

9. Click the OK button in this window.

10. Go to the File menu > Exit, and exit Software Manager.

Use either of the paths described earlier in this section to access Octane Hardware Central.

IRIX 6.4 Users: IRIS InSight Document Library

From the Toolchest > Selected, choose File QuickFind and type InSight in the window.
Also from the Toolchest > Help, choose Online Books for Desktop Help, SGI End User,
and SGI Administrator documentation. From the Toolchest > Help, choose InfoSearch to
search online books, man (reference) pages, product release notes, and “How Do I?”
(task-based help).
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IRIX 6.5 Users: InfoSearch

From the Toolchest > Help > InfoSearch, type the name of the book or topic for which you
need information. InfoSearch searches online books, man pages, and release notes
covering end user, developer, and system administrator information.

Technical Publications Library

If you have access to the Internet, you can view most manuals, man pages, and release
notes on the Technical Publications Library. The URL is:

http://techpubs.sgi.com/library

The Console Window

The small box next to the toolchest is the console window; see Figure 1-22. It looks like a
small box because it has been minimized. You can open it to its full size by clicking on it
with the left mouse button. Many of the error messages that the system generates appear
in this window.

Figure 1-22 Console Icon

Clicking on the console brings up the IRIX shell in which you can type IRIX commands.
For information on IRIX commands, choose the Toolchest > Help > Online Books >
SGI_End User. Open the Desktop Users Guide and look for “Using IRIX Commands.”
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Shutting Down and Powering Off the Octane Workstation

There are two ways to shut down and power off your Octane workstation:

• Use the power button to shut down the system software and power off.

• Use the Toolchest > System > Shut Down System to shut down the system software
and return to the System Maintenance menu or power off.

Using the Power Button to Shut Down and Power Off the Octane
Workstation

Figure 1-23 Powering Off the Octane Workstation

To use the power button to power off the Octane workstation, follow the instructions
below.

1. Open the door on the front of the Octane workstation.

2. Press the power button.

3. The notifier shown in Figure 1-24 appears on your screen within a few seconds.
Then the system powers off automatically within the next minute.

Power button
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Chapter 1: Getting Started
Figure 1-24 System Shutdown Notifier

4. Turn off the monitor by pressing the monitor power button.

If the system does not power off, either it never came up all the way or the operating
system is hung. If you do not see any activity for several minutes, follow the steps below.

Figure 1-25 Pressing the Reset Button

1. Press the power button again.

Note: If you press the power button a second time, the system powers off
immediately, but it is not a clean shutdown. Avoid using this method unless the
system does not respond for several minutes after you press the power button the
first time.

Power button

Reset button
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Shutting Down and Powering Off the Octane Workstation
Figure 1-26 Pressing the Power Button

2. If pressing the power button a second time does not work, use a pencil or pen to
press the reset button.

3. If the system still fails to power off, unplug the power cord from the back of the
workstation and contact your service provider.

Power button

Reset button
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Using the Toolchest to Shut Down the Octane Workstation

Figure 1-27 System Shutdown Caution Message

You can use the System menu in the Toolchest to shut down the system. You can also
choose to power off the system by pressing the power button.

1. From the Toolchest > System, choose System Shutdown.

After a few seconds you see the notifier shown in Figure 1-27. At this point you can
either power off the system or shut it down and get the System Maintenance Menu,
allowing you to restart your system.

2. To power off the system, click Power Off the System and then click OK. The screen
clears and you see the notifier shown in Figure 1-28. After a few seconds, the system
powers off.
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Shutting Down and Powering Off the Octane Workstation
Figure 1-28 Shutting Down the System Notifier

You can also shut down and restart the system.

1. To shut down the system and get the System Maintenance Menu (allowing you to
restart your system), from Toolchest > System, choose System Shutdown.

After a few seconds you see the notifier shown in Figure 1-29.

Figure 1-29 Shutting Down the System Caution Notifier

2. Click OK at the notifier shown in Figure 1-29. The screen clears and you see the
notifier shown in Figure 1-30.
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Figure 1-30 System Shutdown Notifier

Next you see the message shown in Figure 1-31.

Figure 1-31 Okay to Power Off Notifier

3. Click Restart. You see the system startup message shown in Figure 1-32.

Figure 1-32 Starting Up the System Notifier

You are finished shutting down, powering off, or restarting your system.
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This chapter provides information about installing and removing CPUs and
memory (DIMM)s in the Octane workstation. It also provides information
about verification procedures.

Installing and Removing the CPU and Memory

Chapter 2





Chapter 2

2. Installing and Removing the CPU and Memory

Since both memory and the processor reside in the same area of the workstation, this
chapter provides information on installing and removing a processor (CPU) or memory
(DIMMs).

The following topics are covered in this chapter:

• “Preparing the Workstation to Remove and Install a CPU and Memory” on page 38

• “Removing the System Module” on page 42

• “Installing and Removing a CPU/Processor” on page 48

• “Installing and Removing Memory” on page 54

• “About Memory” on page 54

• “Replacing the System Module” on page 59

• “Powering On the Octane Workstation” on page 65

• “Verifying Memory Installation” on page 66
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Preparing the Workstation to Remove and Install a CPU and Memory

Figure 2-1 Powering Off the Octane Workstation

To prepare the workstation to install or remove a CPU or memory, follow these steps:

1. Open the cover and push the power button to power off the Octane workstation.
(Step A)

2. Unplug the power cord from the electrical outlet and from the Octane workstation.
(Step B)

3. Press the power switch on the monitor. (Step C)

4. Wait 5 minutes before removing the system module.

Warning: The heat sinks on the CPU and system module become very hot. Wait 5
minutes after powering off the Octane workstation before you remove the system
module. Test before touching the CPU or heat sinks.

Power button

Power cord

Power switch

AB

C
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Preparing the Workstation to Remove and Install a CPU and Memory
Figure 2-2 Removing the Lockbar

5. Remove the lockbar which locks the system module and bezel to the chassis.

■ Unlock the lock at the back of the Octane workstation. (Step A)

■ Pull the lockbar out of the Octane workstation. (Step B)

6. Face the rear of the workstation.

A

B
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Chapter 2: Installing and Removing the CPU and Memory
Figure 2-3 Removing the Cables From the System Module

7. Remove the cables attached to the system module.

System module
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Attaching the Wrist Strap
Attaching the Wrist Strap

Caution: The components inside the Octane workstation are extremely sensitive to
static electricity; you must wear the wrist strap while replacing parts inside the
workstation.

Figure 2-4 Attaching the Wrist Strap to the Chassis

1. Unwrap the first two folds of the band and wrap the exposed adhesive side firmly
around your wrist. (Step A)

2. Unroll the rest of the band and peel the liner from the copper foil at the opposite
end. (Step B)

3. Attach the copper foil to the module you are removing: system module, XIO
module, frontplane, PCI module. Otherwise, use any convenient and exposed
electrical ground, such as a metal part of the Octane workstation. (Step C)

UnrollA

B

C
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Removing the System Module

Figure 2-5 Removing the System Module Screws

Warning: The heat sinks on the CPU and system module become very hot. Wait 5
minutes after powering off the Octane workstation before you remove the system
module. Test before touching the CPU or heat sinks.

1. To remove the system module, you need to power off the system, wait 5 minutes
after powering off the workstation to allow the heat sinks to cool, and attach the
wrist strap. If you have not already done so, go to “Preparing the Workstation to
Remove and Install a CPU and Memory” and follow the instructions through
attaching the wrist strap. Then return here and follow the instructions.

For illustration purposes, the optional PCI module is shown installed.
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Removing the System Module
2. Loosen the captive screws that hold the sliding handles to the Octane workstation.
See Figure 2-5.

Figure 2-6 Locating the Compression Connectors

Look for the two compression connectors when you take the system module out of
the chassis, and do not touch them. They are on the back of the system module, and
connect to the chassis when the system module is installed in the workstation.

Caution: The gold bristled pad on the compression connectors on the back of the
system module is very delicate and easily damaged. Before you remove the system
module, read Appendix B, “Care and Cleaning of the Compression Connector.”

Bristled pad
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Chapter 2: Installing and Removing the CPU and Memory
Figure 2-7 Releasing the System Module From the Frontplane

3. Pull both sliding handles simultaneously until they are completely extended. This
action releases the system module from the workstation.

Caution: To avoid damaging the module, do not attempt to remove the module by
pulling the sliding handles.
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Removing the System Module
Figure 2-8 Removing the System Module From the Chassis

4. Pull the system module from the chassis by grasping the module handle with your
left hand and bracing your right hand against the top of the workstation.

Support the bottom of the module as you pull it out.

5. Place it on a dry, antistatic surface with the CPU and DIMMs facing up. Your
desktop works well.
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Chapter 2: Installing and Removing the CPU and Memory
Figure 2-9 Locating the Compression Connectors

Caution: Do not touch the compression connectors as you remove the system
module. The side of the compression connector that connects to the workstation is
extremely delicate.

See Appendix B for information and care of the compression connectors.

Caution - do not touch
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Removing the System Module
Figure 2-10 Placing the Compression Cap on the Compression Connector

6. Place a cap on each compression connector on the back of the system module.
(Compression connector caps come with the workstation.)

Warning: The heat sinks on the CPU and system module become very hot. Wait 5
minutes before touching them, and then test before touching them.

Caution - do not touch
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Installing and Removing a CPU/Processor

Your Octane workstation uses either a single or a dual CPU (processor). The installation
procedure is the same for a single or dual processor of any speed.

Removing a CPU

Figure 2-11 Removing the Single Processor

To remove a CPU, you must first power off the workstation, wait 5 minutes to allow the
heat sinks to cool, attach the wriststrap, and remove the system module. If you have not
already done so, go to “Preparing the Workstation to Remove and Install a CPU and
Memory” on page 38 and follow the instructions through removing the system module.
Then return to this section and follow these instructions:

1. Loosen the four captive Phillips screws holding the CPU in place. The dual
processor has six screws.

Single processor
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Installing and Removing a CPU/Processor
Figure 2-12 Lifting the Single Processor From the System Module

Caution: Do not remove the four inner screws (not Phillips) holding the heatsink to
the CPU.

2. Slide your fingers under the edge of the single processor closest to the back of the
module, and push up to release it. You may need to use two hands to lift it out.

3. Go to step 4 for instructions on lifting the dual processor from the system module.

Single processor
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Chapter 2: Installing and Removing the CPU and Memory
Figure 2-13 Lifting the Dual Processor From the System Module

4. Slide your fingers under the side bar of the system module and under the dual
processor and push up to release it. After releasing it, lift it out of the system
module.

Dual processor
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Installing and Removing a CPU/Processor
Installing a CPU/Processor

Figure 2-14 Viewing the Connectors on the Underside of the CPUs

To install a CPU, you must first power off the workstation, wait 5 minutes after powering
off the workstation to allow the heat sinks to cool, attach the wriststrap, remove the
system module, and remove a CPU. If you have not already done so, go to “Preparing
the Workstation to Remove and Install a CPU and Memory” on page 38 and follow the
instructions through removing the CPU. Then return to this section and follow these
instructions:

1. Turn over the CPU to determine where the connectors are located. Align the
connectors on the base of the CPU with the connectors on the system board.

2. If you are installing a single processor, place it on the side of the system module
closest to the panel of connectors. See Figure 2-15.

Connectors

Dual processor Single processor
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Chapter 2: Installing and Removing the CPU and Memory
Figure 2-15 Installing a Single Processor

3. Lower the CPU onto the standoffs and connectors as shown in Figure 2-15. (See
Figure 2-16 for an illustration of the dual processor installation.)

4. Tighten the four captive screws to the standoffs. (The dual processor has six captive
screws.)

Single processor

Connectors
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Installing and Removing a CPU/Processor
Figure 2-16 Installing the Dual Processor

You have finished installing the CPU and are ready to replace the system module.

Go to “Replacing the System Module” on page 59.

Dual processor
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Installing and Removing Memory

To install or remove memory, you must power off the workstation, wait 5 minutes after
powering off the workstation to allow the heat sinks to cool, attach the wriststrap, and
remove the system module. Follow the instructions for preparing the workstation and
removing the system module, “Preparing the Workstation to Remove and Install a CPU
and Memory” on page 38 through, “Removing the System Module.” Then return to this
section.

Caution: Dual inline memory modules (DIMMs) are extremely sensitive to static
electricity. Handle the DIMMs carefully and wear the wrist strap to avoid the flow of
static electricity.

About Memory

Before you install DIMMs in your Octane workstation, read the following information.

• Bank 1 (sockets 1 and 2) must always be filled.

– Minimum memory configuration is 64 MB in a bank. (2 x 32 MB DIMM)

– Maximum configuration is 512 MB in a bank. (2 x 256 MB DIMM)

• Banks are filled sequentially; when Bank 1 is full, fill Bank 2. Do not skip banks.

• Each bank is either empty, or contains two DIMMs, one in each of the two sockets.

• Each banks of DIMMS must contain two DIMMs of the same capacity or density
and of the same type.

Capacity refers to the number of megabytes in a DIMM: 32, 64, 128, and so on.

Type refers to the construction of the DIMM. Because DIMM construction cannot be
determined visually, it is important to know that two DIMMs are the same type
before you begin installation. If you insert two DIMMs of different types, the system
does not work. Banked DIMMs and stacked DIMMs are two examples of many
different types of memory.
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Installing and Removing Memory
• SGI DIMMs have color coded labels with a part number in the middle of the label:

– the 32 MB DIMM has a yellow label

– the 64 MB stacked DIMM has a blue label

– the 64 MB DIMM (not stacked) has a green label

– the 128 MB DIMM has a brown label

– the 256 MB stacked DIMM has a red label

• Minimum memory capacity in the Octane workstation is 64 MB. (2 x 32 MB
DIMMs)

• Maximum memory capacity in the Octane workstation is 2 GB. (8 x 256 MB DIMMs)

Figure 2-17 Identifying DIMM Sockets and DIMM Banks

DIMM sockets are labeled between sockets, as shown in Figure 2-17.

Processor

System module

1

2

3

4

Banks

DIMM
sockets

S1

S2

S3

S4

S5

S6

S7

S8
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Removing Memory

If you have not already done so, power off the workstation, wait 5 minutes after
powering off the workstation to allow the heat sinks to cool, attach the wriststrap, and
remove the system module from the chassis. See “Preparing the Workstation to Remove
and Install a CPU and Memory” on page 38 and follow the instructions through
removing the system module. Then return to this page.

Figure 2-18 Locating DIMMs on the System Module

Bank 1

DIMMs

Processor

System module

Bank 2

Bank 3

Bank 4

Compression connector  
do not touch gold plate
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Installing and Removing Memory
1. With the system module lying on a flat, dry, antistatic surface, locate the DIMM
banks and sockets as shown in Figure 2-17 and Figure 2-18.

2. Locate the DIMMs you want to remove.

Caution: Do not touch the connector near the DIMM removal levers.

Figure 2-19 Removing a DIMM

3. Remove the DIMMs.

■ Press down on the latch at the end of the DIMM socket. The DIMM partially
ejects from the socket. (Step A)

■ Remove the DIMM. (Step B)

Note: Both sockets in a DIMM bank must be either empty or populated. If you are
removing one DIMM and not replacing it immediately, also remove the other DIMM
in the bank and replace it when you install a new DIMM.

DIMM sockets

A

B
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Installing Memory

Figure 2-20 Locating the Notches on a DIMM

Before installing memory, see “About Memory” on page 54. If you have not already done
so, power off the workstation, wait 5 minutes after powering off the workstation to allow
the heat sinks to cool, attach the wriststrap, and remove the system module to install
memory. See “Preparing the Workstation to Remove and Install a CPU and Memory” on
page 38 and follow the instructions through removing the system module. Then return
to this page.

DIMMs are notched on the bottom so that they cannot be inserted incorrectly.

1. Insert the DIMM into the socket, gently but firmly. You hear a click as it is seated,
and the latch on the end of the socket moves up.

2. Check to be sure both sockets in the bank are full. DIMMs must be installed in pairs.

You have finished installing memory and are ready to replace the system module.

Notches
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Replacing the System Module
Replacing the System Module

Figure 2-21 Removing the Compression Connector Cap

1. Remove the caps on the compression connectors on the back of the system module.
Do not touch the system module compression connectors as you lift the module into
the workstation.

Caution: Do not insert the system module into the workstation unless the power
cord is unplugged from the electrical socket. Inserting the system module into an
Octane workstation with the power cord connected to an electrical socket causes
damage to the Octane workstation.

Caution - do not touch
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Chapter 2: Installing and Removing the CPU and Memory
Figure 2-22 Supporting the System Module

2. Grasp the system module by its immovable handle and support it with one hand as
you slide it into the chassis.

3. Push the module completely into the chassis using the immovable handle. (Both
sliding handles protrude.) The system module stops when it is slightly out of the
chassis.
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Replacing the System Module
Figure 2-23 Replacing the System Module in the Octane Workstation

4. Push the sliding handles simultaneously to connect the system module to the
workstation.
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Chapter 2: Installing and Removing the CPU and Memory
Figure 2-24 Locking the System Module to the Frontplane

5. Push firmly on the handles to completely lock the system module to the
workstation.

The handles are completely recessed and the system module is flush with the
chassis when it is fully seated and locked to the workstation.
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Replacing the System Module
Figure 2-25 Replacing the System Module Screws

6. Tighten the captive screws in the sliding handles until the system module is
attached to the chassis.

7. Remove the wrist strap.
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Chapter 2: Installing and Removing the CPU and Memory
Figure 2-26 Replacing Cables to the System Module

8. Replace any cables you removed.
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Powering On the Octane Workstation
Powering On the Octane Workstation

Figure 2-27 Powering On the Octane Workstation

1. Plug in the power cord. (Step A)

2. Push the power button on the workstation. (Step B)

3. Press the power switch on the monitor. (Step C)

Note: If the workstation does not boot, reseat the system module.

Power button

Power cord

Power switch

A B

C
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Chapter 2: Installing and Removing the CPU and Memory
Figure 2-28 Installing the Lockbar

4. Replace the lockbar.

■ Open the cover on the front of the Octane workstation.

■ Slide the lockbar into the lockbar slot. (Step A)

■ Insert the lock through the lockbar at the back of the workstation. (Step B)

Verifying Memory Installation

1. After you have powered on your system, go to the Toolchest > System Manager >
Hardware and Devices > “About This System” and check the amount of memory
listed after the “Main Memory” heading.

The amount of memory shown should equal the amount of memory you removed
or installed. For example, if you originally had 256 MB, then removed two 32 MB
DIMMs, the System Manager should show that you have 192 MB of memory.

Push inA

B
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Verifying Memory Installation
2. If the amount of memory is incorrect, follow the directions at the beginning of this
chapter to power off your system and check the installation or removal procedure.

■ Check the angle of the DIMMs. They should be upright and completely seated.

■ Check that each bank is populated with two DIMMS, and that they are the same
type. You must have an even number of DIMMS installed.

■ Check the color of the label on the DIMM. Both DIMMs in a bank must be the
same with the same colored label.

■ Complete the installation or removal procedure. If, after you have powered on
the Octane workstation, checked the amount of memory in “About This
System,” and found that the amount of memory that is registered is still
incorrect, see Chapter 8, “Troubleshooting.”
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Chapter 3

3. Installing and Removing the Power Supply

You rarely need to remove and install a power supply. Because the power supply is
located at the bottom of the Octane workstation and you do not have to open the chassis,
it is easily removed. This chapter provides information on installing or removing a
power supply.

The following topics are covered

• “Preparing the Workstation to Remove or Install the Power Supply” on page 72

• “Removing the Power Supply” on page 73

• “Installing the Power Supply” on page 77
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Chapter 3: Installing and Removing the Power Supply
Preparing the Workstation to Remove or Install the Power Supply

Figure 3-1 Powering Off the Octane Workstation

Before removing the power supply, you must power off the Octane workstation.

1. Open the cover and push the power button to power off the Octane workstation.
(Step A)

2. Unplug the power cable from the electrical socket. (Step B)

3. Press the monitor power switch to power off the monitor. (Step C)

4. Face the back of the workstation.

Power button

Power cord

Power switch

AB

C
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Removing the PCI Module
Removing the PCI Module

If you do not have a PCI module installed, go to the next section.

If you have a PCI module installed, you need to remove it before removing the power
supply. Go to Chapter 4, “Removing the PCI Module” on page 89 for instructions on
removing the PCI module. Then return here and follow the instructions below to remove
the power supply.

Removing the Power Supply

If you have not already done so, power off the Octane workstation and remove the power
cable from the electrical outlet. If it is installed, remove the PCI module as well. See
“Preparing the Workstation to Remove or Install the Power Supply” on page 72 and
follow the directions for powering off the workstation (and removing the PCI module) if
you have not already done so.

You do not need to use the wriststrap when removing the power supply.

Caution: Do not remove the power cable from the power supply until the power supply
is out of the chassis.
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Chapter 3: Installing and Removing the Power Supply
Figure 3-2 Removing the Screws That Hold the Power Supply to the Chassis

Warning: Be sure you have removed the power cable from the electrical socket
before beginning this procedure.

1. Locate the two captive screws near the bottom of the power supply that secure it to
the chassis.

2. Using a Phillips screwdriver, loosen the captive screws until they release from the
chassis.
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Removing the Power Supply
Figure 3-3 Removing the Power Supply From the Octane Workstation

3. Grasp the handle and pull the power supply from the chassis.
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Chapter 3: Installing and Removing the Power Supply
Figure 3-4 Removing the Power Supply Cable

4. Tilt the power supply up, and unplug the power cable.
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Installing the Power Supply
Installing the Power Supply

Figure 3-5 Installing the Power Supply Cable

Follow the steps below to install the power supply.

1. Tilt the power supply upward and plug the power cable in the power supply.
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Chapter 3: Installing and Removing the Power Supply
Figure 3-6 Sliding In the Power Supply

2. Slide in the new power supply.

3. Push on the power supply to firmly connect it to the frontplane.

Note: Be sure the tabs (holding the screws) on the power supply are flush with the
chassis.
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Installing the Power Supply
Figure 3-7 Inserting and Tightening the Screws

4. Tighten the screws that attach the power supply to the workstation.

You have finished installing the power supply.

To reinstall the PCI module, turn to Chapter 4, “Installing the PCI Module” on page 119
and follow the instructions through powering on the Octane workstation.

If you are not installing a PCI module, you are ready to power on the Octane workstation.
Go to the next section.
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Chapter 3: Installing and Removing the Power Supply
Powering On the Octane Workstation

Figure 3-8 Powering On the Octane Workstation

1. Plug the power cable into an electrical outlet. (Step A)

2. Press the power button on the Octane workstation. (Step B)

3. Press the power switch on the monitor. (Step C)

Power button

Power cord

Power switch

A B

C

80



This chapter provides information about installing and removing PCI boards
and the PCI module in the Octane workstation.

Installing and Removing PCI Boards

Chapter 4





Chapter 4

4. Installing and Removing PCI Boards

PCI boards in the Octane workstation install into a container that slides into the
workstation. The container, the PCI module, is small and lightweight, and you can install
PCI boards away from the chassis loction. This chapter contains information on installing
and removing PCI boards and the PCI module.

The following topics are covered in this chapter

• “About the PCI Module and Boards” on page 85

• “Preparing the Workstation to Install or Remove PCI Boards” on page 86

• “Removing the PCI Module” on page 89

• “Opening the PCI Module” on page 94

• “Identifying a PCI Slot” on page 96

• “Installing a PCI Board” on page 96

• “Removing a PCI Board” on page 109

• “Installing the PCI Module” on page 119

• “Verifying the PCI Board Installation” on page 127
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Chapter 4: Installing and Removing PCI Boards
Figure 4-1 Workstation Without the Optional PCI Module

The PCI module is an optional module of the Octane workstation. If your Octane
workstation does not have a PCI module, a blank panel covers the opening for the
PCI module.

PCI blank panel
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About the PCI Module and Boards
Figure 4-2 Workstation With the Optional PCI Module

If your Octane workstation has a PCI module installed, it protrudes from the rear of the
workstation. See Figure 4-2.

About the PCI Module and Boards

Total power for the PCI module (the sum of power for all boards from all power supply
rails) must not exceed 45.0W (average 15.0W per board).

The Octane PCI module is a 5V system environment.

See Appendix C, “Technical Specifications,” for more information about power
specifications for the PCI module.

PCI module
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Chapter 4: Installing and Removing PCI Boards
The PCI module supports full- or half-size boards. A maximum of three boards can be
installed in the PCI module. The PCI module allows installation of PCI boards that have
extra long I/O connectors. Possible board combinations are

• two full-size boards and one half-size board.

• one full-size board and two half-size boards.

• three half-size boards.

Preparing the Workstation to Install or Remove PCI Boards

Figure 4-3 Powering Off the Octane Workstation

To install or remove a PCI board, power off the Octane workstation, remove any cables
attached to the PCI module, and attach a wrist strap.

Power button

Power cord

Power switch

AB

C
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Preparing the Workstation to Install or Remove PCI Boards
1. Open the cover and push the power button to power off the Octane workstation.
(Step A)

2. Unplug the power cord from the electrical outlet. (Step B)

3. Press the monitor power switch to turn off the monitor. (Step C)

4. Face the rear of the workstation.

Figure 4-4 Removing the Cables From the PCI Module

5. Remove any cables from the PCI module.
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Chapter 4: Installing and Removing PCI Boards
Attaching the Wrist Strap

Caution: The components inside the Octane workstation are extremely sensitive to
static electricity; you must wear the wrist strap while replacing parts.

Figure 4-5 Attaching the Wrist Strap to the Chassis

1. Unwrap the first two folds of the band and wrap the exposed adhesive side firmly
around your wrist. (Step A)

2. Unroll the rest of the band and peel the liner from the copper foil at the opposite
end. (Step B)

3. Attach the copper foil to the module you are removing: system module, XIO
module, frontplane, or PCI module. Otherwise, use any convenient and exposed
electrical ground, such as a metal part of the Octane workstation. (Step C)

UnrollA

B

C
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Removing the PCI Module
Removing the PCI Module

Figure 4-6 Identifying the Compression Connector on the PCI Module

Installing or removing PCI boards requires removing the PCI module from the
workstation.

Caution: The compression connector on the back of the PCI module is delicate and
easily damaged. Do not touch or bump the gold area of the compression connector.

See Appendix B, for information about and care of the compression connectors.

Caution - do not touch
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Chapter 4: Installing and Removing PCI Boards
Figure 4-7 Removing the Screws From the PCI Module

1. Loosen the two captive screws that secure the PCI module to the Octane
workstation until they are disconnected from the chassis.
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Removing the PCI Module
Figure 4-8 Opening the Release Lever

2. Pull the release lever toward you and to the right.

Release lever
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Chapter 4: Installing and Removing PCI Boards
Figure 4-9 Sliding the PCI Module From the Chassis

3. Slide the PCI module from the chassis. Place it on a dry, antistatic surface. Your
desktop works well.
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Removing the PCI Module
Figure 4-10 Installing a Cap on the Compression Connector

4. Place a cap on the compression connector on the back of the PCI module. (Extra
compression connector caps came with the workstation.)

Caution:  Do not touch
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Chapter 4: Installing and Removing PCI Boards
Opening the PCI Module

Figure 4-11 Loosening the Screws on the PCI Module

If the PCI module is out of the workstation, go to step 1. If your PCI module is still in the
workstation, go to “Preparing the Workstation to Install or Remove PCI Boards” on
page 86 and follow the instructions through removing the PCI module.

1. Turn the PCI module as shown in Figure 4-11.

2. Loosen the screws holding the PCI module door closed, but do not remove them.
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Opening the PCI Module
Figure 4-12 Opening and Removing the PCI Module Door

3. Pull the PCI module door up and off. The release hinge allows the module door to
slide up and off.

Release hinge
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Chapter 4: Installing and Removing PCI Boards
Identifying a PCI Slot

Figure 4-13 Identifying PCI Slots

PCI physical slots and slots identified in software have the same designation. See
Figure 4-13.

• The top slot is PCI ID #1.

• The middle slot is PCI ID #2.

• The bottom (half-sized) slot is PCI ID #3.

Installing a PCI Board

If you have not already done so, turn to “Preparing the Workstation to Install or Remove
PCI Boards” on page 86 for instructions on powering off the Octane workstation through
removing the PCI module. Then return here for instructions on installing a PCI board.

PCI ID #1

PCI ID #2

PCI ID #3
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Installing a PCI Board
Figure 4-14 Removing the Blank I/O Panel Screw

Caution: PCI boards are extremely sensitive to static electricity: You must wear the wrist
strap while removing or installing PCI boards. The wrist strap prevents the flow of static
electricity, which could damage the PCI board.

1. Remove the screw from the blank I/O panel that is in the slot in which you wish to
install the PCI board.
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Chapter 4: Installing and Removing PCI Boards
Figure 4-15 Removing the Blank I/O Panel

2. Remove the blank I/O panel by pulling it up. Use the metal knob on the side of the
blank panel to help lift it out of the PCI module.

3. Keep the I/O blank panel. If you later remove a PCI board and do not replace it, you
must reinstall the blank panel.
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Installing a PCI Board
Figure 4-16 Inserting a PCI Board Into the PCI Module

4. Insert the PCI board into the connector in the PCI module. Push gently but firmly
until the PCI board snaps into place. If you have a board with an extra-long
connector which prevents you from inserting the board, skip to step 6.
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Chapter 4: Installing and Removing PCI Boards
Figure 4-17 Inserting the Board Screw

5. Insert and tighten the screw that holds the PCI board to the PCI module.
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Installing a PCI Board
Figure 4-18 Placing the Door on the PCI Module

6. Fit the hinged door to the PCI module.

Release hinge
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Chapter 4: Installing and Removing PCI Boards
Figure 4-19 Tightening the PCI Module Door Screws

7. Tighten the I/O door screws.

Go to “Installing the PCI Module” on page 119.
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Opening the I/O Door for Extra-Long Connectors
Opening the I/O Door for Extra-Long Connectors

Figure 4-20 Removing the Screws Holding Other Boards to the I/O Door

1. If there are boards installed in the PCI module, and you want to open the I/O door,
remove the screws holding the boards to the I/O to allow the door to open.

Do not remove any blank I/O panels. They are directly attached to the door and
open with it.
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Chapter 4: Installing and Removing PCI Boards
Figure 4-21 Removing the PCI Module Door Screws

2. If you have a board with an extra-long connector, completely remove the screws
that hold the door to the PCI module.

Figure 4-22 Opening the I/O Door

3. Slide the I/O expansion door open.

I/O door expansion device
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Opening the I/O Door for Extra-Long Connectors
Figure 4-23 Inserting a PCI Board With an Extra-long Connector

4. Insert the PCI board into the connector in the PCI module. Press gently but firmly
until the board snaps into place.

Figure 4-24 Closing the I/O Door

5. Close the I/O door.
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Chapter 4: Installing and Removing PCI Boards
Figure 4-25 Inserting and Tightening the I/O Door Screws

6. Insert the screws that hold closed the I/O panel door.

Figure 4-26 Replacing the I/O Panel Screw

7. Insert the screws that holds all PCI boards to the I/O panel door.
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Opening the I/O Door for Extra-Long Connectors
Figure 4-27 Reconnecting the PCI Module Door

8. Fit the hinged door to the PCI module.

Release hinge
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Chapter 4: Installing and Removing PCI Boards
Figure 4-28 Tightening the Screws of the PCI Module Door

9. Tighten the module door screws.

Go to “Installing the PCI Module” on page 119.
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Removing a PCI Board
Removing a PCI Board

Figure 4-29 Removing the Screw

If you have not already done so, go to “Preparing the Workstation to Install or Remove
PCI Boards” on page 86 and follow the instructions from powering off the workstation
through opening the PCI module. Then return here for instructions on removing the PCI
board.

1. Remove the screw holding the PCI board to the module.

2. If you have a board with an extra-long connector, skip to step 5. Otherwise, go to
step 3.
109



Chapter 4: Installing and Removing PCI Boards
Figure 4-30 Extracting the PCI Board

3. Grasp the PCI board on the top edge to extract it.

4. Pull up until the board releases. The board may be difficult to remove because it fits
snugly into the connector in the PCI module.

If it is very difficult to remove, go to step 5, open the I/O door expansion device,
and grasp the PCI board on the top and edge of the card and pull it up and out.
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Removing a PCI Board
Figure 4-31 Opening the I/O Door

5. Remove the screws holding any other PCI boards to the module so that the I/O
door can swing open.

Figure 4-32 Removing the I/O Door Screws

6. Remove the screws holding the I/O to the PCI module.
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Chapter 4: Installing and Removing PCI Boards
Figure 4-33 Opening the I/O Door

7. Slide the I/O door open.

Opening the I/O door allows the I/O connector at the end of the PCI board
clearance so that the board can be easily removed and provides space for gripping
the edges of the two boards that are close to the sides of the PCI module.

Extra-long connector

I/O door expansion device
112



Removing a PCI Board
Figure 4-34 Removing a PCI Board

8. Grasp the PCI board on the top edge to extract it.

9. Pull up until the board releases. The board may be difficult to remove because it fits
snugly into the connector in the PCI module.

To install a PCI board, go to “Installing a PCI Board” on page 96.

If you are not installing another PCI board in the same slot, insert an I/O blank
panel. Go to the next step.
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Chapter 4: Installing and Removing PCI Boards
Figure 4-35 Closing the I/O Door

10. Close the I/O door.

Figure 4-36 Inserting the I/O Door Screws

11. Insert, but do not tighten, the screws holding the I/O door to the PCI module.
114



Removing a PCI Board
Figure 4-37 Inserting the I/O Blank Panel

12. Install an I/O blank panel in the I/O door in place of the PCI board. Use the knobs
on the back of the blank panel to position it.

Note: Be sure to place the tip of the I/O blank panel inside the groove at the bottom
of the PCI module. Do not position the tip outside the groove.
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Chapter 4: Installing and Removing PCI Boards
Figure 4-38 Attaching the Blank Panel to the I/O Door

13. Attach the blank panel to the I/O door with a screw.
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Removing a PCI Board
Figure 4-39 Reconnecting the PCI Module Door

14. Fit the hinged door to the PCI module.

Release hinge
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Chapter 4: Installing and Removing PCI Boards
Figure 4-40 Replacing the Screws of the PCI Module Door

15. Tighten the door screws.

Go to “Installing the PCI Module” on page 119.
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Installing the PCI Module
Installing the PCI Module

Figure 4-41 Removing the Screws From the Blank Panel

If you are installing a PCI module for the first time, you need to remove the blank panel.

1. Using a Phillips screwdriver, remove the screws from the blank panel.
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Chapter 4: Installing and Removing PCI Boards
Figure 4-42 Removing the Blank Panel

2. Using a flathead screwdriver, place the tip of the screwdriver in the slot at the top
and middle of the blank panel.

3. Pull the panel outward and lift it up and out.

Note: Save the blank panel for reuse, should you ever need to remove the PCI cage.
Either the PCI cage or the blank panel must be in place at all times.

PCI blank panel
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Installing the PCI Module
Figure 4-43 Removing the Cap From the Compression Connector

4. Remove the cap from the compression connector on the back of the PCI module,
and save it for future use.

Caution - do not touch
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Chapter 4: Installing and Removing PCI Boards
Figure 4-44 Replacing the PCI Module

5. Place the PCI module in the chassis and push it until the tabs are flush with the
chassis.

Tab
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Installing the PCI Module
Figure 4-45 Closing the Release Lever

6. Close the release lever by pushing it to the left until it is parallel with the PCI
module.

Release lever
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Chapter 4: Installing and Removing PCI Boards
Figure 4-46 Replacing the PCI Screws

7. Tighten the captive screws that hold the PCI module to the chassis.
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Installing the PCI Module
Figure 4-47 Replacing the PCI Cables

8. Connect any PCI cables to the PCI connectors.

9. Remove the wrist strap.

You have finished replacing the PCI module and are ready to power on the Octane
workstation.

Go to “Powering On the Octane Workstation” on page 126.
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Chapter 4: Installing and Removing PCI Boards
Powering On the Octane Workstation

Figure 4-48 Replacing the Power Cord and Turning On the Octane Workstation

1. Face the front of the workstation.

2. Connect the workstation’s power cord to an electrical outlet. (Step A)

3. Press the power button to power on the Octane workstation. (Step B)

4. Press the monitor power switch to power on the monitor. (Step C)

Power button

Power cord

Power switch

A B

C
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Verifying the PCI Board Installation
Verifying the PCI Board Installation

You can verify your PCI board installation. See the Octane PCI Module Installation Guide
for specific instructions on checking the installation.

1. If your PCI board does not appear to be functioning, repeat the installation
procedure.

2. If the PCI board still appears to not function, call your authorized service
representative.
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This chapter provides information about installing and removing XIO boards
in the Octane workstation. It also provides information about the XIO module.

Installing and Removing XIO Boards
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Chapter 5

5. Installing and Removing XIO Graphics and Option
Boards

Several XIO graphics and option board configurations are possible in the Octane
workstation. Depending on the size of the graphics board, you may install either two or
three option boards, such as the Octane Personal Video option board, the Ultra SCSI
option board, or a second graphics board to create a Dual Head configuration. Option
board configuration information is included in the documentation that ships with the
option board. Option and graphics boards attach to the XIO module, which slides out of
the chassis for board installation.

The following topics are covered in this chapter

• “About the XIO Module and XIO Boards” on page 133

• “Preparing the Workstation to Install or Remove XIO Boards” on page 134

• “Removing the XIO Module” on page 137

• “Removing a Blank Panel With Baffle” on page 153

• “Removing a Graphics Board, Option Board, or Blank Panel With No Baffle” on
page 142

• “Installing a Graphics Board, Option Board, or Blank Panel” on page 154

• “Placing a Texture Memory Option Board on the Graphics Board” on page 166

• “Removing a Texture Memory Option Board From the Graphics Board” on page 170

• “Installing the XIO Module” on page 173

• “Powering On the Octane Workstation” on page 178

• “Verifying the Graphics or Option Board Installation” on page 178
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-1 Locating the XIO Module

The XIO module in the Octane workstation is on the right side as you face the back of the
chassis.

XIO module

I/O panel
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About the XIO Module and XIO Boards
About the XIO Module and XIO Boards

The XIO module is the holding mechanism for XIO graphics or XIO option boards and
holds up to four boards. It can be thought of as a tray to which boards are attached. The
four quadrants of the XIO module are Slots A, B, C and D. Slots D and A are on one side,
Slots B and C on the other. A graphics board, option boards, or blank panel attaches to
each slot on the XIO module. The only exception is the Octane/SSI or SSE or
Octane/MXI or MXE graphics boards, which occupy two slots, A and D.

• The XIO graphics boards must be placed at the top and right as you insert the XIO
module, or they may overheat and be damaged.

• The graphics board must be in slot A or slots A and D. (See the Octane Dual Head
Installation Guide or the Octane Duo Installation Guide for specific locations of dual
graphics boards.)

• Option boards occupy slots B and C and possibly D.

• Graphics and option boards may be linked by flex cables.

• Protective blank panels must be placed in unused slots.

• A baffle must be in place on two side-by-side blank panels.

• Caps for the compression connectors come with the workstation.

• If you lose a screw that holds the graphics boards, single-layer option boards, or
blank panels to the XIO module, use M3 x 8 mm size screws. (See your option board
manual for the screw size for attaching option boards with daughterboards
attached.)
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Preparing the Workstation to Install or Remove XIO Boards

Figure 5-2 Powering Off the Octane Workstation

1. Open the cover and push the power button to power off the Octane workstation.
(Step A)

2. Unplug the power cord. (Step B)

3. Power off the monitor by pressing the power switch. (Step C)

4. Wait 5 minutes before removing the XIO module.

Warning: The heat sinks on the XIO boards become very hot. Wait 5 minutes after
powering off the Octane workstation before you remove the XIO module. Test
before touching any of the XIO boards.

Power button

Power cord

Power switch

AB

C
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Preparing the Workstation to Install or Remove XIO Boards
Figure 5-3 Removing the Monitor Cable

5. Remove all the cables from the XIO module (only one is shown here).

To monitor
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Attaching the Wrist Strap

Caution: The components inside the Octane workstation are extremely sensitive to
static electricity; you must wear the wrist strap while replacing parts inside the
workstation.

To attach the wrist strap, follow these steps:

Figure 5-4 Attaching the Wrist Strap

1. Unwrap the first two folds of the band and wrap the exposed adhesive side firmly
around your wrist. (Step A)

2. Unroll the rest of the band and peel the liner from the copper foil at the opposite
end. (Step B)

3. Attach the copper foil to the XIO module. Otherwise, use any convenient and
exposed electrical ground, such as a metal part of the Octane workstation.
(Step C)

UnrollA

B

C
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Removing the XIO Module
Compression Connector Caution

Figure 5-5 Identifying the Compression Connector

Caution: The compression connectors on all XIO graphics boards and most option
boards are very delicate and easily damaged. Do not touch or bump the gold bristled
pad. The connectors are on the side opposite the handle. Do not grab the back of the XIO
module when you remove it, or the compression connectors may be damaged.

Before you remove the XIO module, read Appendix B, “Care and Cleaning of the
Compression Connector.”

Removing the XIO Module

Before removing the XIO module, you must power off the Octane workstation, wait 5
minutes to allow the heat sinks to cool, and attach the wrist strap. If you have not already
done this, go to “Preparing the Workstation to Install or Remove XIO Boards” on
page 134 and follow the instructions through attaching the wrist strap. Then return here
and follow the directions.

Bristled pad
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-6 Removing the XIO Module Screws

Warning: The heat sinks on the XIO boards become very hot. Wait 5 minutes after
powering off the Octane workstation before you remove the XIO module. Test before
touching any of the XIO boards.

1. Loosen the two captive screws in the XIO module handles with the supplied
Phillips screwdriver until the screws are disconnected from the chassis.
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Removing the XIO Module
Figure 5-7 Releasing the XIO Module

2. Grasp the handles and pull until the XIO module protrudes about an inch from the
chassis.

The handles and XIO module move out about one inch before the I/O panels move.
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-8 Removing the XIO Module

3. Grasp the XIO module along its length, and support the base of the module as you
remove it from the chassis.

XIO module
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Removing the XIO Module
Figure 5-9 Placing the XIO Module on Its Side

The handle area protrudes when the XIO module is out of the chassis. When the
handle protrudes, the identification slots for the XIO boards, (D and A on one side,
B and C on the other), are visible. See Figure 5-9.

Note: Do not push on the handle area after you have removed the XIO module. The
XIO module locks to the workstation only if the handle area is protruding.

4. Place the XIO module on a flat, antistatic surface. An empty antistatic bag on your
desk works well.
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I/O panel

XIO module

Slot D

Cap
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-10 Placing a Cap on the XIO Compression Connector

5. Place a cap on the XIO graphics board compression connector. Spare caps come with
the workstation. See Figure 5-10.

Caution: Do not touch or bump the gold (front) surface of the XIO compression
connector to prevent damaging the connector. Place a protective cap on XIO
compression connector to prevent damage when the XIO boards are removed from
Octane. See Appendix B, “Care and Cleaning of the Compression Connector,”

Removing a Graphics Board, Option Board, or Blank Panel With No Baffle

Before removing a graphics board, option board, or blank panel, you must power off the
Octane workstation, wait 5 minutes, attach a wrist strap, and remove the XIO module. If
you have not already done so, see “Preparing the Workstation to Install or Remove XIO
Boards” on page 134 and follow the instructions through removing the XIO module. Be
sure to also read “About the XIO Module and XIO Boards” before beginning your task.

Caution - do not touch
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Removing a Graphics Board, Option Board, or Blank Panel With No Baffle
Before you install a graphics or option board, you need to remove a protective blank
panel or other graphics or option board. The processes for removing a standalone
graphics board, option board, and blank panel are the same. The process for removing
an option board attached by flex cables to the graphics board involves extra steps.

Figure 5-11 Identifying the Slots Used by an XIO Board

Warning: The heat sinks on the XIO boards become very hot. Wait 5 minutes after
powering off the Octane workstation before you remove the XIO module. Test before
touching any of the XIO boards.

Graphics boards may use one slot (A) or two (D and A). Figure 5-11 shows the Octane/SI
or SE graphics board in Slot A. Graphics boards using two slots have the I/O connector
positioned in slot A.
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-12 Placing the Cap on the XIO Compression Connector

Caution: Do not touch the gold XIO compression connector.

1. Before you remove a graphics board or option board, place a cap on the XIO
compression connector to prevent accidental damage when removing the board.

For this task... Go to...

Removing the cable guard and flex cables
from the graphics board. (Flex cables are also
attached to an option board).

Step 2 in this section.

Removing the graphics or option board; no
flex cables or cable guard.

Step 8 in this section.

Removing a blank panel with a baffle and
adjacent blank panel.

“Removing a Blank
Panel With Baffle”.

Caution - do not touch
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Removing a Graphics Board, Option Board, or Blank Panel With No Baffle
Figure 5-13 Removing the Standoff Screw

To remove the cable guard and flex cables, follow these steps:

2. Using a Phillips screwdriver, remove the screw from the standoff. See Figure 5-13.
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145



Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-14 Sliding the Cable Guard Beneath the I/O Panel

3. Slide the cable guard toward the I/O panels. This action releases the cable guard
from the option board.
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Removing a Graphics Board, Option Board, or Blank Panel With No Baffle
Figure 5-15 Removing the Cable Guard

4. Swing the cable guard away from the graphics and option board. (Step A)

5. Slide the cable guard from beneath the I/O panels. (Step B)

You are finished removing the cable guard.
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-16 Replacing the Graphics Board Screw

6. Replace the screw in the graphics board standoff.
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Removing a Graphics Board, Option Board, or Blank Panel With No Baffle
Figure 5-17 Releasing the Flex Cables From the Graphics Board

7. Detach the flex cables from the graphics board beginning with the cable labeled C.

■ Press down on one release lever on the end of the flex cable (Step A), then on
the other (Step B).

Note: Pressing both release levers at the same time usually results in the
connector remaining seated.
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Cable connector
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release connectors

C
B
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B
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-18 Removing the Flex Cables From the Graphics Board

■ Pull up on the connector until it releases.

■ Remove flex cable B, then flex cable A, following the procedure for flex cable C.

I/O panel

ABC

Graphics or option board
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Removing a Graphics Board, Option Board, or Blank Panel With No Baffle
Figure 5-19 Removing the Screws From the XIO Board

8. Using the supplied Phillips screwdriver, remove the screws from the graphics
board, option board, or blank panel. Use the list below to determine the number
and type of screws to remove.

Different board types require different numbers and types of screws.

• The Octane SI or SE graphics board uses four screws

• The Octane/SSI or SSE or /MXI or MXE graphics board uses six screws

• Option boards with flex cables may use extra-long screws and a spacer

• Option boards (or blank panels) without flex cables use four screws

If you are removing a blank panel next to another blank panel, skip to “Removing a
Blank Panel With Baffle” on page 153.

Screws

Graphics board
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-20 Removing the Graphics Board

9. Grasp the graphics board, blank panel, or option board on the I/O panel and on the
side of the board with no connectors and lift.

10. With the same side facing up, place the board on a clean, antistatic surface.

It is a good idea to save the blank panel to reinstall in the workstation should you
need to remove an option board.

Skip to “Installing a Graphics Board, Option Board, or Blank Panel” on page 154.
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Removing a Blank Panel With Baffle
Removing a Blank Panel With Baffle

Figure 5-21 Removing the Baffle

1. If you are removing a blank panel next to another blank panel, first remove the
baffle.

■ Remove the four screws from the baffle.

■ Lift the baffle off the blank panels and keep it for possible future use.

■ Replace two screws into the blank panel you are not removing

2. Remove the final two screws from the blank panel you are removing.

3. Lift the blank panel from the XIO module.

Go to “Installing a Graphics Board, Option Board, or Blank Panel” to replace a graphics
board, option board, or install a blank panel.

Note: It is best to use your option board installation manual when installing an option
board.
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Slot C
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Installing a Graphics Board, Option Board, or Blank Panel

Before installing a graphics board, option board, or blank panel, you must power off the
Octane workstation, wait 5 minutes for the heat sinks to cool, attach a wrist strap, and
remove the XIO module. If you have not already done so, see “Preparing the Workstation
to Install or Remove XIO Boards” on page 134 and follow the instructions through
removing the XIO module. Be sure to also read “About the XIO Module and XIO Boards”
before beginning your task.

Caution: Do not remove the cap on the XIO compression connector until your
installation process is complete.

1. Have the XIO module lying on its side with the handles facing you.

2. Determine which slot or slots you will use to install the graphics board, option
board, or blank panel.

Note: The Octane/SI or SE graphics board always goes in slot A, and the Octane/SSI
or SSE and Octane/MXI or MXE boards go in slots D and A. Option boards with
three flex cables always go in slot B.

Tip: Orient the board so the thick side is up. The thick side has more depth from
components, heat sinks, or daughterboards.
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Installing a Graphics Board, Option Board, or Blank Panel
Figure 5-22 Replacing the Screws

3. Place the graphics board, option board, or blank panel on the standoffs.

Some option boards must be placed in designated slots. Always check your option
board installation manual for information about board placement or other pertinent
information.

Caution: Some option boards with three flex cables use extra-long screws and
possibly a spacer that fits over the screw closest to the flex cables. Use these
extra-long screws only with the option board. Using extra-long screws with a
graphics board or blank panel damages the standoffs.

See step 8 in “Removing a Graphics Board, Option Board, or Blank Panel With No
Baffle,” for a listing of the number and types of screws used by option boards,
graphics boards, and blank panels.

4. Replace the screws, tightening the board or panel to the standoffs.
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
5. Remove the caps from all XIO compression connectors. Keep the caps to protect the
compression connector should you ever remove any XIO board.

Note: Be sure all the slots are filled, with a graphics board, option boards, or blank
panels. The system does not cool properly if any of the slots are empty.

Attaching Flex Cables to the Graphics Board

It is always best to use the option board installation manual for information on installing
and removing option boards because many option boards have slot dependencies. These
instructions provide generic information for attaching flex cables to graphics boards.

If you are installing Go To

An option board (without flex cables) “Installing the XIO Module”.

Option board with flex cables  “Attaching Flex Cables to the
Graphics Board”.

Blank panel next to another blank panel “Installing the Baffle”.
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Installing a Graphics Board, Option Board, or Blank Panel
Figure 5-23 Attaching the Option Board Flex Cables to the Graphics Board

1. Turn the XIO module so that the graphics board in slot A or D and A is facing you.

2. Attach the connector with the shortest flex cables to connector A on the graphics
board. Press down on the middle of the connector to ensure proper seating.

3. Lay the middle flex cable through the release levers of connector A, then attach the
connector. Press down on the middle of the connector to seat it.

Graphics board

ABC

A
B

C

Release levers
UP
157



Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-24 Attaching the Flex Cables to the Graphics Board

4. Lay the longest flex cable through the release levers of connectors A and B. Connect
the connector and press down on it to fully seat it.

Go to the next section, “Installing the Cable Guard” on page 159.
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Installing a Graphics Board, Option Board, or Blank Panel
Installing the Cable Guard

This section describes how to install the cable guard.

Figure 5-25 Identifying Parts for the Cable Guard Installation

The cable guard protects the flex cables from being scratched or caught when the XIO
module is inserted or removed from the workstation.

The cable guard slides under the I/O panels and attaches beneath the screw on the
graphics board and behind the spacer or standoff on the option board.
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-26 Removing the Screw From the Graphics Board

1. Remove the screw from the graphics board, as shown in Figure 5-26.
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Installing a Graphics Board, Option Board, or Blank Panel
Figure 5-27 Sliding the Cable Guard Under the I/O Panels

2. Slide the two prongs under the I/O panels. (Step A)

3. Push the cable guard toward the flex cables, laying the top hook on the top of the
graphics board. (Step B) Continue placing pressure on the flex cables.
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-28 Sliding the Cable Guard Behind the Standoff

4. Press down on the center hole of the cable guard and slide it toward the back of the
XIO module until its half-hook rests behind the spacer or standoff on the option
board.
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Installing a Graphics Board, Option Board, or Blank Panel
Figure 5-29 Attaching the Screw to Anchor the Cable Guard

5. Place the screw from the graphics board through the hook on the cable guard and
the graphics board, and into the standoff on the XIO module. Then tighten it.

If you received a screw with the cable guard, use this longer screw instead of the
screw you just removed from the graphics board.

6. You have finished installing the flex cables and cable guard.

7. Remove the caps from all XIO compression connectors. Keep the caps to protect the
compression connector should you ever remove any XIO board.

8. Go to “Installing the XIO Module” on page 173.
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Installing the Baffle

Figure 5-30 Installing the Baffle on Two Side-by-Side Blank Panels

Install the baffle when you have two side-by-side blank panels.

1. Lay the blank panel over the empty slot.

2. Place the baffle over the two blank panels.

3. Insert and tighten the four screws.

4. Insert the remaining two screws into the remaining holes on the blank panel you are
installing.
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Installing a Graphics Board, Option Board, or Blank Panel
Figure 5-31 Removing the Cap From the XIO Compression Connector

5. Remove the cap from the XIO compression connector.

6. Keep the caps from the XIO compression connectors to place them on the XIO
boards, the system module, or PCI module whenever you remove it from the
Octane workstation.

7. Go to “Installing the XIO Module” on page 173.

Caution - do not touch
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Placing a Texture Memory Option Board on the Graphics Board

Figure 5-32 Locating the Connectors for the Texture Memory Option Board

If you have not already done so, see “Preparing the Workstation to Install or Remove XIO
Boards” on page 134 and follow the instructions through removing the XIO module.

A single texture memory option board installs on the Octane/SI or SE graphics board.
See Figure 5-32. See Figure 5-33 for the location of the connectors on the Octane/SSI or
SSE graphics board.

Use the same process to install texture memory option boards on the Octane/SI or SE and
Octane/SSI or SSE graphics boards. Locate the texture memory option board connectors
on the Octane/SI or SE or Octane/SSI or SSE graphics board.
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Placing a Texture Memory Option Board on the Graphics Board
Figure 5-33 Locating the Connectors for the Texture Memory Option Board on the Octane/SSI
or SSE Graphics Board

Two texture memory option boards install, side by side, on the Octane/SSI or SSE
graphics board. See Figure 5-33.

If you are installing two texture memory option boards on the Octane/SSI or SSE
graphics board, begin with the set of connectors near the D slot designation, as shown in
Figure 5-33.
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-34 Installing the Texture Memory Option Board on the Octane/SI or SE Graphics
Board

1. Align the texture memory option board above the graphics board as shown in
Figure 5-34.

2. Lower the texture memory option board and slide the front edge under the I/O
panel.

3. Align the two long connectors on the underside of the texture memory option board
with the two connectors on the graphics board.

4. Press on the top of the texture memory option board above the connectors to seat
the connectors.

Note: These connectors must be fully seated for the texture memory board to be
recognized.
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Placing a Texture Memory Option Board on the Graphics Board
Figure 5-35 Inserting the Nylon Screw

5. Place and tighten the nylon screw that came with the texture memory board
through the hole in the I/O panel and into the hole on the texture memory option
board as shown in Figure 5-35.

Caution: Do not use a metal screw; your board does not perform properly. Order
another nylon screw from your authorized service provider if this screw is lost or
damaged.

If you are installing texture memory boards on the Octane/SSI or SSE board, repeat the
above steps to install the second board. (After the texture memory boards are installed,
the Octane/SSI or SSE graphics board is known as the Octane/MXI or MXE graphics
board.)

You are finished installing the texture memory option board and are ready to install the
XIO module. Go to “Installing the XIO Module” on page 173.
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Removing a Texture Memory Option Board From the Graphics Board

If you have not already done so, see “Preparing the Workstation to Install or Remove XIO
Boards” on page 134 and follow the instructions through removing the XIO module.

A single texture memory option board is installed on the Octane/SI or SE graphics board.
Two texture memory option boards are installed on the Octane/MXI or MXE graphics
board. Use the same process to remove texture memory option boards from the
Octane/SI or SE and Octane/MXI or MXE graphics board.

If you are removing texture memory option boards from the Octane/MXI or MXE
graphics board, begin with the texture memory option board closest to slot A.

Figure 5-36 Removing the Screw Holding the Texture Memory Option Board to the I/O Panel

1. Remove the nylon screw from the I/O panel.
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Removing a Texture Memory Option Board From the Graphics Board
Figure 5-37 Releasing the Texture Memory Option Board From the Graphics Board

2. Push up on the ends of the texture memory option board farthest from the I/O
panel to release the two connectors beneath.

UP
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-38 Removing the Texture Memory Option Board

3. Lift up and back to remove the texture memory option board from beneath the edge
of the I/O panel.

Caution: If you are removing texture memory option boards from the Octane/MXI
or MXE graphics board, be sure to remove both texture memory option boards.
Follow the instructions in this section. Both texture memory boards must be removed
for the Octane/MXI or MXE graphics board to work properly.

If you are finished removing texture memory option boards, go to the next section,
“Installing the XIO Module” on page 173.
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Installing the XIO Module
Installing the XIO Module

Figure 5-39 Installing Slots A and D of the XIO Module Toward the Interior of the Octane
Workstation

Caution: Replace the XIO module with the graphics boards toward the inside of the
workstation. The boards may be damaged if placed toward the exterior of the
workstation. If the XIO module is inserted with the Octane/SSI or SSE or Octane/MXI
or MXE graphics boards toward the exterior of the workstation, a notifier appears during
power- on telling you to insert the XIO module with the graphics boards toward the
interior of the workstation.
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-40 Replacing the XIO Module

Follow these instructions to install the XIO module:

1. Replace the XIO module in the Octane workstation by sliding the XIO module into
guides on the top and bottom of the workstation.

2. Before you insert the XIO module, make sure the handle portion protrudes in a
locked position from the I/O panels, as shown in Figure 5-40.

If the handles are flush with the I/O panels, the XIO module will stop during
insertion. Pull out the handles until the sliding portion of the XIO module looks like
Figure 5-40, and then continue inserting the XIO module into the chassis.
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Installing the XIO Module
Figure 5-41 Inserting the XIO Module

3. Grasp the handle area with one hand while supporting the XIO module with the
other, and slide the module into the chassis.

4. Use the handles to push the XIO module into a locked position. (The I/O panels are
nearly flush with the workstation when properly inserted, however, there is a slight
variation in the depth of the boards.)

XIO module
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Figure 5-42 Replacing the XIO Module Screws

5. Tighten the captive screws in the handles.

6. Remove the wrist strap.
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Installing the XIO Module
Figure 5-43 Replacing the Monitor Cable

7. Reconnect all XIO cables to the XIO module.

8. Connect any new cables to the XIO module.

You have finished installing an XIO board.

Go to “Powering On the Octane Workstation” on page 178.

To monitor
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Chapter 5: Installing and Removing XIO Graphics and Option Boards
Powering On the Octane Workstation

Figure 5-44 Powering On the Octane Workstation

1. Plug the power cord into an electrical outlet. (Step A)

2. Push the power button on the front of the Octane workstation. (Step B)

3. Push the power switch on your monitor. (Step C)

Verifying the Graphics or Option Board Installation

You can verify your graphics or option board installation by using the hinv command.

To verify that your graphics or option boards are recognized, follow these instructions:

1. From the Toolchest > Desktop, open a UNIX shell.

2. At the prompt, type: hinv.
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Verifying the Graphics or Option Board Installation
3. Look for a line similar to this:

Graphics board: MXI and Graphics board: SI or the name of the option board.

4. If your graphics or option board is not recognized, repeat the installation procedure.

5. If the graphics or option board is still not recognized, see Chapter 8,
Troubleshooting, or the option board manual.

6. If the graphics board or option board is still not recognized, contact your authorized
service representative.
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This chapter provides information about installing and removing external
devices from the Octane workstation.

Installing and Removing External Devices

Chapter 6





Chapter 6

6. Installing and Removing External Devices

This chapter provides basic information about SCSI bus bandwidths and rates,
information about SCSI and serial device cabling, rules for daisy-chaining peripherals,
pointers to configuration documentation, and instructions for installing and removing
external devices. (For information on internal SCSI devices, see Chapter 7, “Installing
and Removing Drives and Front Module Parts.”)

To install a peripheral, first install the external device, power it on, and then power on
the Octane workstation so that the system software can recognize the peripheral.

The following topics are covered in this chapter:

• “About SCSI Buses and Devices” on page 184

• “Installing External SCSI Devices” on page 186

• “About Cables” on page 189

• “Installing Serial Devices” on page 201

• “Installing Audio Devices” on page 204

• “Replacing the Keyboard or Mouse” on page 212
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Chapter 6: Installing and Removing External Devices
About SCSI Buses and Devices

SCSI devices continue to evolve with higher bus bandwidths, faster data transfer rates,
and channels with longer cables and more devices. The Octane workstation contains two
wide buses, one for internal devices and one for external devices.

Table 6-1 compares Ultra and Fast, wide and narrow SCSI rates.

Ultra SCSI is also referred to as Fast-20.

The data transfer rate is also affected by the media speed of the SCSI peripheral. Fast-20
SCSI is not merely “fast SCSI.” The “-20” in the term signifies the maximum number of
megatransfers (millions of 8-bit or 16-bit data transfers per second) that can occur during
an I/O operation.

Data transfer rates are either slow or fast, and are measured in megabytes per second. An
operation is either 8 or 16 bit in size; thus, data transfer rates are dependent on bus width.

By default the Ultra SCSI controller tries to negotiate for wide (16 bit) and for ultra speed.
Table 6-2 provides data burst rate information.

Table 6-1 Comparison of Ultra and Fast, Wide and Narrow SCSI Rates

Wide (16 bit) Bus Narrow (8 bit) Bus

Ultra SCSI (Fast-20) 40 MB/s (peak theoretical rate) 40 MB/s (peak theoretical rate)

Fast SCSI 20 MB/s (peak theoretical rate) 10 MB/s (peak theoretical rate)

Table 6-2 Bus Rate + Operating Mode = Data Burst Rates

Existing Bus Operating Mode Data Burst Rate

8-bit Fast 10 MB second

8-bit Ultra 20 MB second

16-bit Fast 20 MB second

16-bit Ultra 40 MB second
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Cleaning DAT or DLT Drives
Here are some tips to keep in mind when attaching SCSI devices to the Octane
workstation.

• You can mix Ultra and Fast devices on the same bus. You can also mix 16-bit and
8-bit devices on the same bus. The overall performance of a mixed bus can vary
widely.

• To daisy-chain a mix of wide and narrow devices, place the wide devices (as a
group) closest to the Octane workstation where the bus is wide, and place the
narrow devices (as a group) at the end of the daisy chain.

Note: Be sure to use an adapter or other special cable that terminates the upper half
of the SCSI bus when converting from the final wide device to the first narrow
device. Silicon Graphics supplied cables have this integrated into the cable, but not
all third-party cables have the terminator integrated into the cable.

• Unsupported devices may not work with the Octane workstation, and may cause
problems with supported devices.

• The length of combined SCSI cables determines how many devices can be daisy-
chained.

• Set addresses manually only on external SCSI devices. See the device manual for
setting the address on the device. Each device needs to have a unique address.

• Drives can be easily damaged. Handle your drive carefully; do not drop it or handle
it roughly.

Cleaning DAT or DLT Drives

If you use your DAT or DLT drive frequently, magnetic dust or debris can collect on the
heads of the drive. This can make your DAT or DLT tapes unreadable or unwriteable.

If the green LED on the front of the DAT drive flashes at about 5-second intervals, clean
the DAT drive heads. Clean the drive after about every 30 hours of use. Clean DLT drives
more frequently.
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Chapter 6: Installing and Removing External Devices
Follow these steps to clean your DAT or DLT drive:

1. Insert a DAT or DLT cleaning cassette tape.

Note: Be sure to use a cleaning tape authorized by the DAT drive manufacturer.

The drive loads the tape and cleans the heads automatically.

The DAT or DLT drive ejects the cleaning tape when the cleaning is complete.

2. If the green LED on the front of the DAT drive continues to flash at about 5-second
intervals after you have cleaned the drive, you may have a problem with your
cleaning-tape, or your drive may need cleaning by an authorized service provider.

■ First, try cleaning your drive again with a new DAT or DLT cleaning cassette
tape.

■ If the LED continues to flash, take your drive to an authorized service provider
for professional cleaning.

Installing External SCSI Devices

This section explains how to connect external SCSI devices to the Octane workstation.
External devices include

• DAT or DLT tape drives

• CD-ROM drives

• floppy drives

• other external SCSI devices

See “About SCSI Buses and Devices” on page 184 for information about SCSI bus and
device speeds.

Follow the steps in the next few sections to connect an external SCSI device to the Octane
workstation.
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Installing External SCSI Devices
Assigning a SCSI Address to the External Device

You must shut down your system to install an external device, but before doing so you
must assign an address to the device.

Note: Set addresses manually only on external SCSI devices. Bus 1 (the external bus) has
addresses such as 1-1, 1-2, 1-3. The second number is the number the user sets.

• If you currently do not have any external devices attached to your system, you can
assign any number between 1 and 15 (for wide SCSI devices) or 1 and 7 (for narrow
devices) to the new device. Do not use address 0, as this is the system SCSI ID. Skip
to “Setting the SCSI Address on the External Device.”

• If you have at least one external device attached to your system and you are adding
another device, you must check which addresses are assigned to the existing
external devices and then choose a number between 1 and 15 (for wide SCSI
devices) or between 1 and 7 (for narrow SCSI devices) that has not already been
assigned.

Note: Although the Octane workstation allows up to 15 addresses for SCSI devices,
the devices themselves may have dials that allow you to set a number only between
1 and 9.

To check available addresses for external devices, follow these steps:

1. If the Octane workstation is powered off, turn on the system power.

■ Open the door on the front of the Octane workstation.

■ Press and release the power button to power on the system.

2. Log in to your account. For more information on logging in, refer to “Logging Into
the Octane Workstation” on page 24.

3. When the system comes up, from the Toolchest > System > System Manager >
Hardware and Devices, choose “Removable Media Manager.”

You see a listing of your system’s hardware devices and their address numbers.

4. Choose a number between 1 and 15 (for a wide SCSI device) or between 1 and 7 (for
a narrow SCSI device) that is not assigned to your current devices and then go to the
next section, “Setting the SCSI Address on the External Device.”
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Setting the SCSI Address on the External Device

To set the SCSI address on the external device, locate a switch, button, dial, or jumpers
and manually set the address. Use the address you chose in step 4 of the previous section.

If the device has a push button, switch, or dial on the back, follow the steps below. If there
is no switch or dial on the device, see the instructions included with the device.

Figure 6-1 Manually Setting the SCSI Address

1. Take the device out of its box and locate the push-button, switch, or address dial. It
may be on the rear or bottom of the device. An example is shown in Figure 6-1.

2. Use a small screwdriver or pencil tip to set the dial or push the buttons to assign the
address number you chose in step 5 of the previous section.

Caution: Do not assign number 0. This number is reserved for the SCSI controller.
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About Cables

You can attach one or more external devices to the SCSI port on the back of your
workstation. Connecting more than one device is called daisy-chaining. The devices are
connected in a chain, with the first device attached to the SCSI port on the workstation.

The combined length of SCSI cables determines the number of devices that can be
daisy-chained. See Table 6-3 for information on the types of devices and combined cable
lengths you may use.

Caution: Using a cable without controlled impedance may cause your device to not
function. For any external device, it is extremely important that you use a cable of
controlled impedance, and with impedance-matched connectors. Not all cables with the
correct connector work. This is particularly important if you have more than one external
device.

Use the cables and active terminator that came with the wide device, or purchase an
active terminator, if necessary. Use only an active terminator.

Caution: Using other types of cables or terminators can result in your system
malfunctioning.

If you have a device that you want to attach to your system, but you do not have the
appropriate cables, you can order them by contacting your authorized service provider.

To attach an external device, power off the Octane workstation and prepare the device
for installation. Instructions begin in the next section.

Table 6-3 Maximum Combined SCSI Cable Length For Daisy-Chaining Devices

SCSI type Maximum cable length:

Ultra SCSI 1.5 meters

Fast SCSI 2 3 meters

Ultra SCSI and Fast SCSI 2 1.5 meters
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Shutting Down and Powering Off the System

Figure 6-2 Powering Off the Octane Workstation

Shut down and power off the system.

1. Open the door on the front of the Octane workstation. (Step A)

2. Press and release the power button to shut down the software and power off the
system. (Step B)

3. The system powers off automatically.

4. Press the monitor power switch to turn off your monitor. (Step C)

Power button

Power cord

Power switch

AB

C
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Preparing the SCSI Device for Cabling

1. If you are daisy-chaining a new device to a connected device, remove the terminator
from the connector on the last device in the current chain by squeezing the clips on
both sides of the terminator and pulling it off. See Figure 6-3.

2. If this is the only device to be attached to the Octane workstation, leave its
terminator in place.

If no SCSI devices are attached to the Octane workstation, no terminator is needed on the
workstation’s SCSI port.

Figure 6-3 Removing the Terminator From the Last Device on the Daisy Chain
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Cabling the Devices

Caution: Ultra and Fast SCSI devices require higher quality cables than earlier SCSI
devices. Use the cable and active terminator that came with the device. Using other types
of cables or terminators can result in your system malfunctioning.

1. Choose the appropriate SCSI cable to connect the external SCSI device.

Caution: Exceeding the maximum 1.5 or 3 meters combined cable length
recommended for your SCSI type can cause your external SCSI devices to operate
unreliably. (See Table 6-3 for maximum cable length for each type of device or
combination of devices.)

2. Connect the fastest SCSI device or devices to the Octane workstation and each other,
then connect slower devices at the end of the chain. See Figure 6-4.

Figure 6-4 Using the Correct Cables Between Devices and/or the Octane Workstation

8-bit SCSI device

OCTANE

8-bit SCSI device

8-bit SCSI device
16-bit Ultra

SCSI device

16-bit Ultra
SCSI device

16-bit Ultra
SCSI device

50 50 50 68 68 68

68 68 50

68-pin active
terminator 

or or

50-pin active
terminator 

68-pin high density 
to 50-pin Centronics

50-pin active
terminator 

68

68-pin high density 
to 50-pin Centronics
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3. Use the following cables between the Octane workstation and the device, or
between devices:

■ If you are attaching the device to the workstation, use the high-density 68-pin to
Centronics® 50-pin Fast SCSI cable. See Figure 6-4.

■ To daisy-chain an Ultra SCSI device to another Ultra SCSI device, use a 68-pin
to 68-pin cable.

■ To daisy-chain an Ultra SCSI device to a Fast SCSI device, use a 68-pin to 50-pin
Centronics Fast SCSI cable.

Figure 6-5 Comparing Speed of Daisy-Chained Devices

The speed of the devices in the daisy chain is determined by the speed of the active
device. If a slow device is active, the bus runs at a slow speed; if a high-speed device is
active, the bus runs at a high speed.

OCTANE

8-bit Fast SCSI-2 device
10 MB/sec

or or

8-bit Fast SCSI-2 device
10 MB/sec

Speed = 10 MB/sec

Speed = 40 MB/sec

Speed = 10 MB/sec 
                             (8-bit device active)

16-bit Ultra SCSI device
40 MB/sec

16-bit Ultra SCSI device
40 MB/sec

16-bit Ultra SCSI device
40 MB/sec

8-bit Fast SCSI-2 device
10 MB/sec

= 40 MB/sec 
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Connecting the SCSI Devices

Figure 6-6 Connecting an External SCSI Device to the Octane Workstation

1. Connect the single device, or first of several devices.

■ Connect one end of the cable to the Octane workstation or the back of another
device.

SCSI
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Installing External SCSI Devices
■ Connect the other end of the SCSI cable to one of the SCSI connectors on the
back of the device and secure the clips on each side of the connector.

Figure 6-7 Daisy-Chaining an External SCSI Device to Another External SCSI Device

■ Connect one end of the cable to the open connector on the first device, as shown
in Figure 6-7.

■ Attach the other end to one of the connectors on the device you are adding.
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Figure 6-8 Connecting the Terminator and Power Cable to an External Device

2. Connect the terminator to the last device in the daisy chain. (Step A) Be sure to
secure the clips on each side of the terminator. The terminator is designed to fit only
one way.

3. Connect power cables to each device and to an electrical outlet.(Step B)

Note: Remember to turn on the external devices first and then your workstation to
make sure the devices are recognized.

You are now ready to power on your system and check to make sure that the device is
recognized.

Power cable

A

B
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Powering On the Octane Workstation

Figure 6-9 Powering On the Octane Workstation

1. Plug in the power cord. (Step A)

2. Replace the lockbar (if one was removed).

■ Open the cover on the front of the Octane workstation.

■ Slide the lockbar into the lockbar slot.

■ Insert the lock through the lockbar at the back of the workstation.

3. Push the power button on the workstation. (Step B)

4. Press the power switch on the monitor. (Step C)

Power button

Power cord

Power switch

A B

C
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Testing the External Device

After you’ve attached the device to your workstation, check to make sure your system
recognizes the device.

The system automatically sets up the system software for most external devices you
install and places an icon on the desktop.

To check the system configuration, follow these steps:

Figure 6-10 Turning On External Devices and the Octane Workstation

1. Turn on the external device first. External devices can be turned on in any order.
(Step A)

Tip: Always turn on the external device before turning on the workstation; otherwise,
the system does not recognize the device.

Switch

Power button

Power cord

Power switch

A

B

C

D
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2. If your workstation is powered off, turn on the system power. (Step B)

■ Open the door on the front of the Octane workstation.

■ Press and release the power button to turn on the system. (Step C)

■ Press and release the power switch on your monitor. (Step D)

After a few moments, the system starts up.

3. When you see the login screen, log in to your account. For more information on
logging in, go to Chapter 1, “Logging Into the Octane Workstation” on page 24.

If the device is installed correctly, you see an icon for it on the desktop. Figure 6-11 shows
the icon for a CD-ROM drive.

Figure 6-11 Identifying the CD-ROM Icon

You can also use the System Manager to check that the external device is shown correctly.

1. From the Toolchest > System > System Manager > Hardware and Devices > choose
Removable Media Manager. You see a window showing the installed external
devices.

2. Look for the device you installed under Shared Resources. This information is also
available by opening an IRIX shell and typing hinv.

If the device you installed does not appear:

1. Power off the system.

2. Check that you’ve connected the correct SCSI cable to the device or between
devices.

3. To daisy-chain a mix of wide and narrow devices, place the wide devices (as a
group) closest to the Octane workstation where the bus is wide, and place the
narrow devices (as a group) at the end of the daisy chain.
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4. If the device is the last SCSI device on the daisy chain, make sure it has a terminator
installed on it.

5. Restart the system and check the System Manager listing or hinv listing again.

The software automatically recognizes any device you install. Use Table 6-4 for more
information on various SCSI external devices.

Table 6-4 Additional Information on External SCSI Devices

Installed device: For Information on: Go to:

Floppy drive Formatting and
ejecting a disk

“Formatting an External Floppy Disk
Drive” on page 201

CD-ROM drive Special instructions for
setting up a CD-ROM
others can access

Additional information

Toolchest > Help > Online Books> End User
bookshelf > Personal System Administration
Guide, “Setting Up SCSI Peripherals”

Toolchest > Help > Online Books > End User
bookshelf IRIX Admin: Peripheral Devices,
and search for “CD-ROM, Floptical, and
Floppy Disk Drives”

Tape drive Backing up data onto a
tape

Toolchest > Help > Online Books > End User
bookshelf > Personal System Administration
Guide > ”Backing Up and Restoring Files”

Printer Setting up a printer Toolchest > System > System Manager >
Hardware and Devices > Printer Manager

For general information, go to Toolchest >
Help > Online Books > End User bookshelf
> Personal System Administration Guide
>“Setting Up Network, Peripheral, and
Printer Connections”
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Formatting an External Floppy Disk Drive

If you are using the drive as an IRIX device, follow these steps to format a floppy disk, if
necessary:

1. From the Toolchest choose System > System Manager > Hardware and Devices >
Removable Media Manager.

A window appears with icons of the recognized devices.

2. Select your device by clicking on it.

3. Click the Format button.

Floppy disks take about 2 minutes to format.

For more information on formatting disks, choose Online Books from the Help toolchest
and search for “Formatting Floppy and Floptical Disks” in IRIX Admin: Peripheral
Devices.

You are finished formatting the floppy disk.

To eject a floppy disk from an external floppy drive, press the eject button on the floppy
device.

Installing Serial Devices

This section tells you how to install serial devices. Serial devices include

• dials and button boxes

• digitizer tablets

• console terminals

• modems
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About Serial Ports

The Octane workstation has two PC-compatible serial ports. Each port can also be
configured to operate in other modes and adapter cables are available to simplify
interconnection for those modes. For more information, see Appendix C or Octane
Hardware Central.

Figure 6-12 Locating the Serial Ports on the System Module

Attaching the Device

To install a serial device, follow these steps:

1. Locate the serial ports on the back of the Octane workstation, as shown in
Figure 6-12.

Serial ports are labeled 1 and 2 and are DB9 connectors.

2. Unpack the serial device and cables.

Serial ports

1
2

202



Installing Serial Devices
Figure 6-13 Plugging In the Serial Cable

Table 6-5 Serial Port Assignment

If you are installing: Use:

A console terminal Serial port 1

Any other serial device Either serial port

Serial device

Power cord
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3. Attach the serial device cable.

■ See the instructions that came with the serial device for detailed instructions on
how to connect the cable to the device.

■ Plug the other end of the cable to the serial connector on the back of the Octane
workstation.

4. Plug in the serial device’s power cable (if any).

■ Plug the socket end of the power cable into the power connector on the back of
the serial device.

■ Plug the other end into a grounded three-pronged wall outlet or power strip.

Configuring the Device

Once the device is connected to the workstation, you need to configure it. Choose Online
Books from the Help toolchest. Choose the Personal System Administration Guide, and
search for “Setting Up Serial Peripherals.”

Installing Audio Devices

All audio ports are located on the upper portion of the system module and include

• Microphone (in)

• Speakers/headphone (out)

• Speaker power (out)

• Analog Line level I/O

• Coaxial Digital I/O

• Optical Digital I/O
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Figure 6-14 Audio Ports on the System Module

To connect an audio device, plug the device cable into the appropriate port.

Use the Audio Panel found in the Toolchest > Desktop > Control Audio to make
adjustments to audio.

For other audio information, from the Toolchest > Help, choose either:

• Online Books > End User > Media Tools User’s Guide.

• “How Do I,” if you have a specific audio task you wish to perform.

In Out

Microphone

Speakers/headphones

Speaker power

Analog line level In/Out
InR

L

Out

Coaxial digital In/Out

Optical digital  In

Optical digital Out
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Installing the Microphone

Figure 6-15 Installing the Microphone

Attach the microphone to the Octane workstation.

1. Place the microphone cord through the slot in the microphone base.

2. Slide the microphone into the base. See Figure 6-15.

3. Place the microphone on the monitor in the center and to the front.

Microphone
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4. Drape the cord over the back of the monitor. Draping the cord over the side of the
monitor causes the microphone to point away from the user, reducing the quality of
the sound.

5. Attach the microphone cable to the microphone port on the Octane workstation.

For pinout and technical specification information, see Appendix C.

Installing the Speakers and Headphones

The speakers connect to the Octane workstation on the system module. If you choose to
use the headphones without the speakers, plug the headphones directly into the speaker
port. Otherwise, insert the headphones into the jack on the front of the right (active)
speaker.

Before connecting the speakers to the Octane workstation, power it off. For instructions
on shutting down and powering off the Octane workstation, turn to “Shutting Down and
Powering Off the System” on page 190. Then return here for instructions on attaching the
speakers.
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Figure 6-16 Setting Up the Speakers

1. Place the left (passive) speaker on the left side of the monitor and the right (active)
speaker on the right side of the monitor. (The left [passive] speaker has a cord
permanently attached to it.)

2. Run the cord from the left (passive) speaker behind the monitor.

3. Attach the left (passive) speaker cord to the right (active) speaker. Use the port
marked L. See Figure 6-16.

Left (passive) speaker

Right (active) speaker

Power
208



Installing Audio Devices
Figure 6-17 Attaching the Speaker Cables to the Active Speaker

4. On the cable with double connectors on each end, locate the end with one female
connector and one male connector.

5. Attach the female power connector to the middle port on the right (active) speaker.

6. Attach the male connector to the port labeled R on the right (active) speaker.

Right (active) speaker

Power

To speaker port
on workstation

To left speaker

Power

Speakers
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Figure 6-18 Attaching the Speaker Cables to the Octane Workstation

7. Attach the other end of the speaker power and audio cable to the Octane
workstation.

■ Attach the smaller tipped power connector to the Octane speaker power port.

■ Attach the larger tipped connector to the Octane speaker port.

8. Press the power button on the front of the active speaker.

9. Power on the Octane workstation. Go to “Powering On the Octane Workstation” on
page 213.

For pinout and technical information, see Appendix C, “Technical Specifications,” or
Octane Hardware Central.

speaker

power
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About Analog Line Level Audio

The analog line level audio ports are color-coded. Red is right. White is left. Input is
upper. Output is lower. These ports are compatible with consumer devices such as stereo
receivers and VCRs, as well as with professional audio equipment.

For more pinout and technical information, see Appendix C, “Technical Specifications.”

About Coaxial Digital Audio

The coaxial digital audio ports are color-coded. Output is white. Input is red. These ports
are compatible with consumer devices with coaxial digital interfaces, CD players, as well
as professional audio equipment.

This port is in accordance with AES-3id recommendations for 75 ohm 1 V peak-to-peak
coaxial connection of AES3-1992 interfaces.

For pinout and technical information, see Appendix C, “Technical Specifications.”

About the Optical Digital Port and Cable

A red LED is visible in the optical digital Out port or cable tip when audio is activated.
Optical digital In is the upper port. Optical digital Out is the lower port.

These ports are compatible with other equipment displaying the ADAT® optical logo, as
well as consumer devices such as CD players with digital optical interfaces.

Cover the optical digital port with a cap when is not in use to keep out dust and debris.

Note: Do not touch the tip of the fiber optic cable, or performance may be reduced.

Optical digital cable should be three meters or less. Using a longer cable may cause
performance to be reduced.

For pinout and technical information, see Appendix C, “Technical Specifications” or
Octane Hardware Central.
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Replacing the Keyboard or Mouse

Figure 6-19 Disconnecting the Mouse and Keyboard

1. See “Shutting Down and Powering Off the System” on page 190 to shut down the
system.

It is recommended that you connect the keyboard to the keyboard port, and the
mouse to the mouse port. However, both work in the either port. You must power
off the workstation to switch the ports.

Note: While you can disconnect and reconnect it to its port while the system is on,
you cannot switch ports while the Octane workstation is on.

For pinout and technical information, see Appendix C, “Technical Specifications.”

2. When the workstation is shut down, disconnect the mouse or keyboard from its port
on the back of the workstation.

3. Connect the new mouse or keyboard cable to the workstation.

4. Power on the workstation.

To keyboard

To mouse
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Powering On the Octane Workstation

Figure 6-20 Powering On the Octane Workstation

1. Plug in the power cord to an electrical outlet. (Step A)

2. Press the power button on the Octane workstation. (Step B)

3. Press the power switch on the monitor. (Step C)

Power button

Power cord

Power switch

A B

C
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This chapter provides instructions on installing and removing system and
option drives, the light module, the system fan, frontplane assembly, and
plastic cover of the Octane workstation.

Installing and Removing Drives and Front
Module Parts
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Chapter 7

7. Installing and Removing Drives and Front Module
Parts

This chapter provides information on installing and removing drives and parts on the
front of the Octane workstation, behind the bezel. Installing a hard drive is an easy task
requiring no tools or screws. It is unlikely that you will need to replace the light module,
frontplane, system fan, or external plastics. Replacing the system fans, frontplane, and
external plastics are complicated and lengthy tasks, and are best performed by an
experienced user.

The following topics are covered in this chapter:

• “Installing and Removing Internal Drives” on page 217

• “Replacing the Light Module” on page 235

• “Removing and Installing the Frontplane Module and System Identification
Module” on page 237

• “Removing and Installing the System Fan” on page 245

• “Removing and Installing the Plastics: Top and Base” on page 250

Installing and Removing Internal Drives

This section tells you how to install internal drives in the Octane workstation. Internal
drives include the system disk drive, secondary hard disk drives, and DAT and
DLT drives.

Caution: Drives can be easily damaged. Handle your drive carefully; do not drop it or
handle it roughly.
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About Internal Drives

• Unsupported devices may not work with the Octane workstation, and may cause
problems with supported products.

• All internal devices have a 3.5-inch form factor.

• Set addresses manually only on external SCSI devices; internal SCSI devices
(drives) are on a separate bus and are automatically given an address when they are
inserted. Each bus has a unique address: Bus 0 (internal devices) has addresses such
as 0-1, 0-2, 0-3; the system drive is SCSI ID 0-1, the option drive above it is SCSI
ID 0-2, and the option drive at the top of the Octane workstation is SCSI ID 0-3. Bus
1 (external devices) has addresses such as 1-1, 1-2, 1-3.

Tip: To determine the total capacity and megabytes available on your disks, go to the
Toolchest > System > File System Manager and click the Get Info button.

Shutting Down and Powering Off the System

Figure 7-1 Powering Off the Octane Workstation and the Monitor

Power button

Power cord

Power switch

AB

C
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To shut down and power off the system, follow these steps:

1. Open the front cover.

2. Press and release the power button to shut down the software and power off the
system. The system powers off automatically. (Step A)

3. Press the monitor power switch to turn off your monitor. (Step B)

4. Disconnect the power cable from the back of the workstation. (Step C)

Removing the Bezel

Figure 7-2 Locating the Lockbar on the Front of the Octane Workstation

Lockbar slot
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To remove the bezel, you first shut down and power off the system. If you have not
already done so, go to “Shutting Down and Powering Off the System” on page 218. Then
return here and follow these steps:

1. Locate the lockbar. If no lockbar is in place, skip to step 4.

Figure 7-3 Unlocking and Removing the Lockbar

2. Unlock and remove the lockbar, if it is in place. (Step A)

3. Close the door on the front of the Octane workstation. (Step B)

A

B
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Figure 7-4 Pressing the Bezel Release Buttons

4. Press both bezel release buttons.
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Figure 7-5 Removing the Bezel

5. Remove the bezel by tilting it forward, then lifting it from its release hooks at the
bottom.
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Installing an Internal Option Drive

Figure 7-6 Identifying the Option Drive Bays

To prepare the Octane workstation before installing an internal drive, see “Shutting
Down and Powering Off the System” on page 218 and follow the directions through
removing the bezel.

The option drive bays are the two top drive bays. Install an option drive in either one.

The Octane workstation automatically assigns an address to an internal drive. The
system drive is SCSI ID 0-1, the drive directly above it is SCSI ID 0-2, and the upper
option drive is SCSI ID 0-3.

Light module

System drive

Option drive bays
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Figure 7-7 Sliding In an Optional Drive

1. Lift the handle on the drive to a horizontal position, and slide the drive into the
drive bay. The drive handle is the same color as the drive. See Figure 7-7.

2. Slide the drive in gently until you feel solid resistance. The drive is connected to the
frontplane when the front of the drive is flush with the chassis.

Caution: Pushing the drive into the frontplane with force can damage the drive.

Option drive bays

Handle
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Figure 7-8 Locking the Drive

3. With the drive completely inserted, rotate the handle downward to lock the drive in
the workstation.

You have completed installing an option drive and are ready to remove the blank panel
on the bezel.

Drive handle
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Removing the Blank Panel

Figure 7-9 Opening the Door on the Bezel

After installing a new option drive, you remove a blank panel from the bezel before
replacing the bezel.

1. Place the bezel on a flat surface so that the door is facing up.

2. Open the door.

3. Locate the blank panel for the drive bay in which you installed the option drive.

Blanking panels

Vent
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Figure 7-10 Pushing the Blank Panel Free

4. Press down on the blank panel. It pops out the back of the bezel.

5. Keep the blank panel. You must replace it if you ever remove the drive.

Caution: To prevent damage to your Octane workstation, you must place a blank
panel in the bezel if you have removed a drive. The blank panel ensures proper
airflow through the workstation.

6. Go to “Replacing the Bezel” on page 256.

Blanking panels

Vent
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Removing Internal Option Drives

Figure 7-11 Lifting the Drive Handle to Unlock the Drive

To remove an internal option drive, go to “Shutting Down and Powering Off the System”
on page 218 and follow the instructions through removing the bezel. Then return here.

1. Lift the drive handle to unlock the drive.

Option drive
228



Installing and Removing Internal Drives
Figure 7-12 Sliding Out the Option Drive

2. Pull the drive directly toward you to remove it from the drive bay.

To install a drive in the option drive bay, go to “Installing an Internal Option Drive” on
page 223.

To leave the drive bay empty, replace the blank panel before replacing the bezel, go to the
next section.

Replacing a Blank Panel

If you removed a secondary drive and do not intend to replace it, you must inform the
system that the drive is no longer there and replace the blank panel.

1. Remove the bezel. See “Removing the Bezel” on page 219. Then return here for
instructions on replacing the blank panel.

2. Place the bezel face down on the flat surface with the door closed. (Take care to
place the bezel on a surface that does not scratch or mar the surface.)

3. Locate the appropriate opening for the blank panel, opposite the empty drive bay,
and place the blank panel in it.

Option drive
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Figure 7-13 Pushing the Blank Panel Free

4. Press the blank panel until both sides snap firmly into place.

For more information, from the Toolchest > Help > Online Books > End User bookshelf,
choose the Personal System Administration Guide and search for “Removing a Disk.”
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Replacing the System Drive

Figure 7-14 Locating the System Drive

To replace the system drive, you must shut down the Octane workstation and remove the
bezel. If you have not completed these steps, go to “Shutting Down and Powering Off the
System” on page 218 and follow the instructions through removing the bezel.

Caution: Do not remove the system drive unless you have a new drive to replace it. The
drive needs to remain in place to prevent damage to the Octane workstation.

The SCSI ID of the system drive is 0-1.

Light module

System drive

Option drive bays
231



Chapter 7: Installing and Removing Drives and Front Module Parts
Figure 7-15 Unlocking the System Drive

1. Locate the system drive.

2. Raise the handle to a horizontal position.

Figure 7-16 Removing the System Drive

3. Pull the system drive out of the Octane workstation.

Light module

System drive

Option drive bays

System drive

Option drive bays
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Figure 7-17 Inserting the New Drive

4. Replace the system drive.

■ Lift the handle.

■ With the handle fully extended, gently slide the drive into the drive bay. The
drive is connected to the frontplane when the front edge of the drive is flush
with the chassis.

Caution: Pushing the system drive in with force can damage the drive.

System drive

Option drive bays
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Figure 7-18 Locking the System Drive

5. Rotate the handle down to lock the system drive to the workstation.

Go to “Replacing the Bezel” on page 256 and follow the instructions through powering
on the Octane workstation. When you see the login screen, you are ready to log in. Return
to this section to test the internal drive.

Testing an Internal Drive

The workstation automatically sets up the system software for most internal devices you
install and places an icon on the desktop.

Once you install the drive, follow these steps to check that the system recognizes the new
drive.

1. Log in to your account. For more information on logging in, refer to “Logging Into
the Octane Workstation” on page 24.

2. If the device is installed correctly, you see an icon for it on the desktop. Double-click
the icon to set up the drive.

Handle down
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3. You can also use the System Manager to check that the drive is shown correctly.

■ From the Toolchest > System > System Manager > Hardware and Devices,
choose Disk Manager. You see a list of installed drives.

■ Choose the drive, and click the Get Info button.

If the drive you installed does not appear, power off the system and make sure the drive
is completely seated in the slot. Then restart the system and check the System Manager
listing again.

Replacing the Light Module

Figure 7-19 Locating the Light Module

The light module provides the light for the light bar on the front of the Octane
workstation. The light module is located on the sheet-metal face, behind the bezel.

Light module
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To replace the light module, go to “Shutting Down and Powering Off the System” on
page 218 and follow the instructions through removing the bezel. Then return to this
section and follow the instructions below.

The light module is directly under the system drive.

Figure 7-20 Removing the Light Module

1. Squeeze both top and bottom wings together at both ends of the light module and
gently pull straight back.

2. If the light module does not release, squeeze more firmly until it releases from the
workstation.

3. Discard the module.

Light module
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Figure 7-21 Inserting the Light Module

4. Insert the new light module.

■ Align the two hollow plastic pins on the module with the two solid metal pins
on the sheet metal cap.

■ Slide the module onto the sheet-metal face until the module snaps into place.
Make sure both sides snap firmly into place.

You have finished the light module installation and are ready to replace the bezel. Go to
“Replacing the Bezel” on page 256 and follow the instructions through powering on the
Octane workstation.

Removing and Installing the Frontplane Module and System Identification Module

Caution: The components on the frontplane module are extremely sensitive to static
electricity; you must wear the wrist strap while working with the frontplane module.

Light module
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Attaching the Wrist Strap

Figure 7-22 Attaching the Wrist Strap

Caution: The components inside the Octane workstation are extremely sensitive to
static electricity; you must wear the wrist strap while replacing parts inside the
workstation.

1. Unwrap the first two folds of the band and wrap the exposed adhesive side firmly
around your wrist. (Step A)

2. Unroll the rest of the band and peel the liner from the copper foil at the opposite
end. (Step B)

3. Attach the copper foil to the module you are removing: system module, XIO
module, frontplane module, PCI module. Otherwise, use any convenient and
exposed electrical ground, such as a metal part of the Octane workstation. (Step C)

UnrollA

B

C
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Task Information

Replacing the frontplane module requires a number of steps from preparing the
workstation to removing modules. Before you begin, find some bookmarks to help you
organize your task.

Also see the diagrams of the workstation in the front of Chapter 1 of this guide to learn
the workstation’s part names.

Be sure to have the replacement part beside you before removing the frontplane module.

To replace the system fan you perform the following tasks. Instructions for completing
the tasks follow the task list.

• Prepare the workstation: shut down and power off, remove the bezel, and attach the
wrist strap.

• Remove the system drive, option drives, and light module.

• Remove all the cables and modules from the back of the workstation.

• Remove the frontplane module.

• Remove and the system fan.

• Reinstall everything and start the system.

Preparing the Workstation to Remove the Frontplane Module

1. Go to “Shutting Down and Powering Off the System” on page 218 and follow the
instructions through removing the bezel. Then return to this section.

2. On the back of the Octane workstation:

■ Disconnect the system module from the chassis by unscrewing the captive
screws and pulling the system module an inch or two from the chassis, or
remove it. (See Chapter 2 for help disconnecting or removing this module.)
Then return to this section.

■ Disconnect the PCI module from the chassis by unscrewing the captive screws
and pulling the PCI module an inch or two from the chassis, or remove it. (See
Chapter 4 for help disconnecting or removing this module.) Then return to this
section.
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■ Disconnect the power supply from the chassis by unscrewing the captive
screws and pulling the power supply an inch or two from the chassis, or
remove it. (See Chapter 3 for help disconnecting or removing this module.)
Then return to this section.

■ Disconnect the XIO module from the chassis by unscrewing the captive screws
and pulling the XIO module an inch or two from the chassis, or remove it. (See
Chapter 5 for help disconnecting or removing this module.) Then return to this
section.

3. On the front of the Octane workstation:

■ Remove the system drive and any option drives. Go to “Replacing the System
Drive” on page 231 and “Removing Internal Option Drives” on page 228 to
remove the system drive and any option drives that are installed.Then return to
this section.

■ Remove the light module. Go to “Replacing the Light Module” on page 235 for
instructions on removing the light module. Then return to this section.

You are ready to begin removing the frontplane module.
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Removing the Frontplane Module

Figure 7-23 Locating the Screws Holding the Frontplane Module to the Chassis

1. If you have not already done so, go to “Removing and Installing the Frontplane
Module and System Identification Module” on page 237 and follow the instructions
before you begin with this section.

2. Place an antistatic bag on a clean, antistatic surface. Your desktop works well.

3. Loosen the six captive screws holding the frontplane module to the chassis until the
screws are loose in their sockets.

4. Place your hand inside the drive bay, and lift the frontplane module out of the
chassis.

Caution: The frontplane module is large and unwieldy. Steady it with you free hand
on the edge of the frame as you remove it from the chassis.
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Figure 7-24 Placing the Frontplane Module Face Down on a Clean Surface

5. Gently place it face down, on a clean, antistatic surface.

6. To adjust the position of the frontplane module, handle it by the metal frame to
avoid damaging components.

If you are replacing the frontplane module with a new frontplane module, go to the next
section. You must remove the system identification module from the old frontplane
module and place it on the new frontplane module.

If you removed the frontplane module as part of the task of replacing the system fan, go
to “Removing and Installing the System Fan” on page 245 for further instructions.

System identification
module

Metal frameDrive bays

System fan
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Removing the System Identification Module

Figure 7-25 Sliding Out the System Identification Module

Remove the system identification module only when replacing the frontplane module.

1. Remove the system identification module.

■ Lift up on the metal retaining clip.

■ Slide the system identification module to the side and out.

2. Place the system identification module on the new frontplane.

■ Lift up on the retaining clip.

■ Slide the system identification module under the clip.

You are ready to install the frontplane. Go to the next section for instructions on
installing the frontplane.
243



Chapter 7: Installing and Removing Drives and Front Module Parts
Installing the Frontplane Module

Figure 7-26 Tightening the Captive Screws on the Frontplane Module

If you have not already done so, go to “Removing and Installing the Frontplane Module
and System Identification Module” on page 237 and follow the steps through removing
the frontplane module and system identification module. Then return here. You are
ready to install the new frontplane module in the Octane workstation.

1. Grasp the replacement frontplane module by the metal frame on the edge of the
front plane.

2. Lift the frontplane module into place and gently insert it into the Octane
workstation.

3. Tighten the six captive screws.

4. Replace the system drive and any option drives.

5. Replace the light module.
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6. On the back of the Octane workstation, insert or connect to the frontplane:

• the XIO module (see Chapter 5 for help replacing this module)

• the power supply (see Chapter 3 for help replacing this module)

• the system module (see Chapter 2 for help replacing this module)

• the PCI module (see Chapter 4 for help replacing this module)

You have finished replacing the frontplane module and system identification module
and are ready to replace the bezel.

Go to “Replacing the Bezel” on page 256 and follow the instructions through powering
on the Octane workstation.

Removing and Installing the System Fan

Replacing the system fan requires a number of steps from preparing the workstation to
removing modules. Before you begin, find some bookmarks to help you organize your
task.

Also see the diagrams of the workstation in the front of Chapter 1 of this guide to learn
the workstation’s part names.

Have the replacement part beside you before remove the system fan.

Preparing the Workstation to Replace the System Fan

To replace the system fan you perform the following tasks. Instructions for completing
the tasks follow the task list.

• Prepare the workstation: shut down and power off, remove the bezel, and attach the
wrist strap.

• Remove the system drive, option drives, and light module.

• Remove all the cables and modules from the back of the workstation.

• Remove the frontplane module.
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• Remove and the system fan.

• Reinstall everything and start the system.

Follow the instructions below to replace the system fan.

1. Go to “Shutting Down and Powering Off the System” on page 218 and follow the
instructions through removing the bezel. Then return to this section, step 2.

2. Go to “Replacing the System Drive” on page 231 and “Removing Internal Option
Drives” on page 228 to remove the system drive and any option drives that are
installed. Then return to this section for instructions on removing the frontplane
module.

3. Remove the light module. Go to “Replacing the Light Module” on page 235 for
instructions on removing the light module. Then return to this section.

4. Go to “Removing and Installing the Frontplane Module and System Identification
Module” on page 237 and follow the instructions through step 5. (Do not remove
the system identification module.) Then return here for instructions on removing
and replacing the fan.
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Preparing the Workstation to Replace the System Fan
Figure 7-27 Releasing the System Fan From the Back of the Drive Bay

5. Locate the system fan. It is attached to the back of the drive bay.

6. Using a flatsided screwdriver, slide the tip of the screwdriver between the tab and
fan.

7. Tilt the screwdriver to release the fan from the pressure of the tab.

8. Partially lift the fan from the back of the drive bays.
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Figure 7-28 Removing the Fan From the Back of the Drive Bay

9. Gently pull up on the cable connector.

10. Discard the old fan.
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Preparing the Workstation to Replace the System Fan
Figure 7-29 Placing the Fan on the Back of the Drive Bay

11. Gently slide the new cable connector onto the connector on the back of the drive
bay.

12. Place the new fan on the back of the drive bay. The fan snaps into place when
properly aligned.

13. To replace the frontplane module in the chassis, go to “Installing the Frontplane
Module” on page 244. Follow the instructions at the end of that section to replace
the bezel and power on the Octane workstation.
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Removing and Installing the Plastics: Top and Base

To remove the plastics, top or base, you must shut down the system and remove the
bezel. Go to “Shutting Down and Powering Off the System” on page 218 and follow the
instructions through removing the bezel. Then return to this section for instructions on
removing the plastics.

Figure 7-30 Releasing the Plastic Top Cover

1. Locate the two areas to press to release the top cover.

2. Press on these areas and hold.

3. While pressing inward on both areas, pull the cover toward the front. The cover
should slide forward. If the cover does not slide forward, press harder to release the
catches, and slide the cover forward.
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Removing and Installing the Plastics: Top and Base
Figure 7-31 Sliding the Front Cover Forward

4. After the cover is forward, lift it straight up and off the chassis.

5. Replace the new plastic cover.

■ Slide the cover straight down over the chassis.

■ Slide the cover back until it snaps into place.The cover snaps into place when it
is correctly aligned.
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Removing and Installing the Plastic Base

To remove the plastic base, you need to shut down the system, remove the bezel, and
remove the top plastic cover.

To shut down the system, go to “Shutting Down and Powering Off the System” on
page 218 and follow the steps through removing the bezel.

Then go to “Removing and Installing the Plastics: Top and Base” on page 250, the section
directly before these instructions, and remove the plastic top cover. Then return to this
section and begin with step 1.

Figure 7-32 Locating the Release Slots

1. On the base of the workstation, locate the plastic tab located in front of the metal tab
with an arrow.

Chassis

Plastic
release tab 
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Removing and Installing the Plastics: Top and Base
Figure 7-33 Releasing the Plastic Base

2. Use a flat-sided screwdriver to press down on the plastic release tab.

Metal tab

Plastic release tab
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Figure 7-34 Sliding the Chassis Backward

3. While pressing down on the tab, slide the chassis back about one and one half
inches, until it stops. See Figure 7-34.
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Figure 7-35 Lifting the Octane Workstation off the Plastic Base

Warning: Do not attempt to lift the Octane workstation by yourself. It is heavy
and requires two people to safely lift.

4. Lift the chassis straight up and off the plastic base.

5. Place the new plastic base on a clean surface.

6. Align the first four tabs on each side of the chassis with the slots in the base and
lower the chassis onto the base.

7. Slide the chassis forward about one and one half inches until it locks to the base.

8. Place the plastic cover over the chassis and snap it into place.
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You are finished replacing the plastic base and are ready to replace the bezel.

Replacing the Bezel

Figure 7-36 Replacing the Bezel

1. Replace the bezel.

■ Lower the bezel into the lower edge of the chassis.

■ Hook the bezel in place.

■ Rotate the bezel back and into closed position.

You can hear the latches snap into place when the bezel is fully installed.

To replace the lockbar, go to the next step. Otherwise, skip to “Powering On the
Octane Workstation” on page 258.
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Figure 7-37 Replacing the Lockbar

2. Open the door on the front of the Octane workstation.

3. Insert the lockbar into the front of the workstation with the angled end up. (Step A)

4. Insert and close the lock at the back of the Octane workstation. (Step B)

You are now ready to power on the Octane workstation.

Push inA

B
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Powering On the Octane Workstation

Figure 7-38 Powering on the Octane Workstation

1. Plug the power cord into a wall outlet. (Step A)

2. Power on the Octane workstation. (Step B)

■ Press the power button.

■ Close the door.

3. Press the monitor power switch to turn on your monitor. (Step C)

Power button

Power cord

Power switch

A B

C
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This chapter describes how to diagnose hardware problems on the Octane
workstation. It also explains how to run diagnostic tests.

Troubleshooting
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Chapter 8

8. Troubleshooting

This chapter provides information about diagnosing a variety of hardware problems
using the blinking and colored LEDs on the front of the system. It also provides you with
information on how to access and run diagnostics, how to use the non-maskable
interrupt (NMI) button, how to recover from a system crash, and what to do when you
have lost or forgotten the system password.

The following topics are covered in this chapter:

• “Diagnosing the Problem” on page 261

• “Using the LEDs on the Lightbar” on page 262

• “Using the NMI Button” on page 265

• “Recovering From a System Crash” on page 269

• “Disabling the System Maintenance Password” on page 273

• “Returning Parts” on page 278

Diagnosing the Problem

If you suspect there is a problem with your hardware, use these diagnostics to help
isolate and solve the problem:

• Lightbar LEDs - Front of Octane, Diagnostic Chart, Figure 8-1

• Lightbar LEDs - Front of Octane, Diagnostic Chart, Figure 8-2

• Lightbar LEDs - Front of Octane, Diagnostic Chart, Figure 8-3

See also “Using the NMI Button” on page 265.
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Using the LEDs on the Lightbar

Figure 8-1 Lightbar LEDs - Front of Octane, Diagnostic Chart #1

Contact your local Silicon Graphics service provider. Have your system serial number ready for part replacement information.
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Using the LEDs on the Lightbar
Figure 8-2 Lightbar LEDs - Front of Octane, Diagnostic Chart #2

Contact your local Silicon Graphics service provider.  Have your system serial number ready for part replacement information.
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Figure 8-3 Lightbar LEDs - Front of Octane, Diagnostic Chart #3

Contact your local Silicon Graphics service provider.  Have your system serial number ready for part replacement information.
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Using the NMI Button
Using the NMI Button

The Octane workstation has the ability to force a non-maskable interrupt (NMI) to the
system. This can be used when the system is experiencing problems that do not report
any error information. Using the NMI button causes the system to record to a file the
activity of the system when the button is pushed and the system powers down.

Caution: Use of the NMI button results in the loss of any work in progress at the moment
the button is pushed.

Figure 8-4 Locating the NMI Button

See Chapter 7 for instructions on removing the bezel. The recessed NMI button is located
the bezel and beneath the Power and Reset buttons. Use a straightened paper clip to press
the recessed NMI button.

The files generated by the NMI button are used by Customer Support to help diagnose
the specific problem that caused the system to malfunction. The files that are created are
placed in the var/adm/crash directory. Have these files accessible when you contact
Customer Support.

NMI button

Power button

Reset button
265



Chapter 8: Troubleshooting
Accessing the System Maintenance Menu

You may wish to access to System Maintenance Menu for some specialized tasks,
including installing system software, running diagnostics, recovering the sytem,
entering the command monitor, or selecting your keyboard layout.

You can access the system maintenance menu by shutting down the system and
powering off using the Toolchest, or by pressing the power button.

Accessing the System Maintenance Menu From the Toolchest

1. To access the System Maintenance menu from the Toolchest > System choose
System Shutdown.

2. After a few seconds you see the notifier shown in Figure 8-5.

Figure 8-5 System Shutdown Notifier

3. After a few seconds you see the notifier shown in Figure 8-6. At this point you can
power off the system by pressing the power button.

Figure 8-6 Okay to Power Off Notifier

4. After the system is powered off, press the power button to power on. You see the
following notifier:
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Accessing the System Maintenance Menu
Figure 8-7 Stop for Maintenance Notifier

5. Click the Stop for Maintenance button.

6. Choose the option you wish to complete your task.

Accessing the System Maintenance Menu Using the Power Button

To access the System Maintenance menu by using the power button, follow these steps.

1. Press the power button on the front of the Octane workstation and power off.

2. After a few seconds, press the power button and power on.

3. You see the following notifier:

Figure 8-8 Starting Up the System Notifier

4. Click the Stop for Maintenance button.

Choose the option you wish to complete your task.
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Running Diagnostic Tests

Three types of software diagnostics tests are provided on the Octane workstation. Each
is described below:

• “Power-On Tests”

• “Confidence Tests”

• “IDE Tests”

Power-On Tests

These tests run automatically on the major hardware components of the workstation
each time it is turned on. If the tests find a faulty part, the LED in the lightbar on the front
of the workstation is red and there will probably be an error message. See also
“Diagnosing the Problem.”

Confidence Tests

There are confidence tests for the mouse, keyboard, monitor, audio subsystem, external
SCSI devices (excluding hard disks), Presenter, and ISDN connection.

To run the Confidence Tests, from the Toolchest, choose System > Confidence Tests.
Double-click the icon for the part you believe is faulty, and follow the online instructions.

IDE Tests

The Interactive Diagnostic Environment (IDE) tests are more comprehensive than the
Confidence Tests, and take longer (as long as 30-45 minutes) to run. Follow these steps:

1. Turn off the workstation, wait a few seconds, and then turn it on again.

2. When you see the System Startup notifier, click Stop for Maintenance, or press Esc.
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Figure 8-9 Starting Up the System Notifier

3. When you see the System Maintenance menu, choose Run Diagnostics, or type 3
on the keyboard.

Tip: You can stop the tests at any time by pressing Esc.

Note: If you cannot reach the System Maintenance menu, your system is faulty. If
you cannot run the diagnostics, you may have a faulty disk drive or other problem.
Contact your service provider.

4. At the end of the tests you see a message with the results of the tests. Press Enter
and then Esc to return to the System Maintenance menu, from where you can
restart the system.

Recovering From a System Crash

In most cases, your system recovers from a system crash automatically if you reboot it.
If, however, you have lost data on your system disk, and you cannot communicate with
your workstation using the mouse or keyboard, or over the network, follow these
instructions. The instructions assume you have a backup tape of your system that has
been made using the System Manager backup tool, or with the /usr/sbin/Backup
script. You also need a CD with your current IRIX operating system level. If you are
recovering data from a tape on a remote tape device, you need to know the hostname,
tape device name, and IP address of the remote system.

Note: If you need instructions on creating a system disk from the PROM monitor, see
Appendix E, “Regulatory Information.”. Also see the Installation Instructions booklet that
came with your CDs for information on installing the operating system or other software.
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1. Use a pen tip or an unwound paper clip to press the Reset button located on the
front panel.

Figure 8-10 Pressing the Reset Button

2. When you see the System Startup notifier (Figure 8-11), click Stop for Maintenance or
press Esc.

Figure 8-11 System Startup Notifier

3. From the System Maintenance menu, choose Recover System, or type 4 on the
keyboard.

The System Recovery Menu appears (Figure 8-12).

Power button

Reset button
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Figure 8-12 System Recovery Menu

4. If you have a CD-ROM drive connected to your system and the IRIX CD, click Local
CD-ROM. Then click Accept to start. Insert the CD when prompted. The system
takes five minutes or more to copy the information.

If you don’t have a CD-ROM drive, use a drive that is connected to another system
on the network. Click Remote Directory.

5. When a notifier appears asking you for the remote hostname, type the system’s
name, a colon (:), and the full pathname of the CD-ROM drive, followed by /dist.
For example, to access a CD-ROM drive on the system mars, you type

mars:/CDROM/dist

After everything is copied from the CD to the system disk, you can restore your
data from a recent full backup tape. The backup must be one that has been made
using the System Manager backup tool, or with the /usr/sbin/Backup script.

Tip: If you need to check something on your system during the restore process, you
can get a shell prompt by typing sh at most question prompts.

6. If you have a local tape device, you see this message:

Restore will be from <tapename> OK? ([Y]es, [N]o): [Y]

tapename is the name of the local tape device.
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7. If you have a remote (network) tape device, when no tape device is found, or when
you answered “No” to the question in the previous step, you see this message:

Remote or local restore ([r]emote, [l]ocal):

• If you answer “remote,” you have chosen to restore from the network, and you
must know the hostname, tape device name, and IP address of the remote
system. You also need to know the IP address of your system. The IP address,
such as 192.0.2.1, always has four components separated by periods.

• If you answer “local,” you have chosen a tape device that is connected to your
system, and you are prompted to enter the name of the tape device.

8. When you see the following message, remove the CD-ROM, insert your most recent
full backup tape, then press Enter.

Insert the first backup tape in the drive, then press <Enter>,
[q]uit (from recovery), [r]estart:

There is a pause while the program retrieves several files from the tape describing
the system state at the time the backup was made. Then you see this message:

Erase /x filesystem and make new one (y,n)? [n]

It prompts you for every filesystem that was known at the time of the backup.

Read the following to decide whether to answer y or n.

• If you answer n for no, the system tries to salvage as many files as possible.
Then it uses your backup tape to replace the files it could not salvage. Usually
you should answer no, especially if your backup tape is not very recent. If the
file systems were badly damaged, or the backup was from a different level
operating system, you may need to answer yes.

• If you answer y for yes, the system erases the filesystem and copies everything
from your backup tape to the disk. The system loses any information on that
filesystem that you created between now and when you made your backup
tape.

9. You see this message:

Starting recovery from tape.

After two or three minutes, the names of the files that the system is copying to the
disk start scrolling.

After the first tape is complete, if it is the first in a set, you are prompted for the
second tape, and so on.
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After the first tape set (full backup) is completed, you are prompted for any
incremental or additional tapes to be restored.

When all tapes have been restored, you are asked whether you are ready to restart
the system.

When the recovery is complete, you see this message:

Recovery complete, restarting system.

Note: If your backup tapes were old, or you were changing your operating system level,
you should reinstall the operating system from the IRIX CD that came with your system
after system recovery is complete. When you see the Startup System notifier, press Esc
or click Stop for Maintenance. Then click Install System Software. For more information on
installing the operating system, see “Installing Software” in the Personal System
Administration Guide or the Installation Instructions booket that came with your CDs.

Disabling the System Maintenance Password

If you are in the System Maintenance menu, and you choose Install System Software, Run
Diagnostics, Recover System, or Enter Command Monitor, you may be prompted for a
password.

If you do not know the password, you can disable it by installing a jumper (a small cap
that connects two pins) on the system board inside the workstation. The system board is
located in the system module. To install the jumper, you must first remove the system
module.

Go to Chapter 2, “Preparing the Workstation to Remove and Install a CPU and Memory”
on page 38 and follow the instructions through “Removing the System Module.” After
the system module is removed, return here for instructions on disabling the password.

Note: The jumper is a small plastic cap that resides near the CPU. See Figure 8-13. The
jumper sits on the right two of three pins.
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Figure 8-13 Removing the Jumper for Disabling the Password

Follow these steps:

1. Locate the white rectangle printed on the system board at the base of the jumper.
The rectangle has “Disable passwd” beside it. The white rectangle surrounds the
jumper and one pin to the left of the jumper. The jumper is on the middle and right
pins.

2. Pull up on the jumper and remove it.

Caution - do not touch
274



Enabling the System Maintenance Password
3. Place the jumper on the left and middle pins within the rectangle. The password is
now disabled.

4. Return to Chapter 2, “Replacing the System Module” on page 59 and follow the
instructions through powering on the Octane workstation.

Enabling the System Maintenance Password

After you have powered on the Octane workstation, you can choose another system
maintenance password.

1. Power on the Octane workstation, if you have not already done so.

2. Go to the Toolchest > Help > InfoSearch > Online Books > SGI End User > Personal
System Administration Guide. Go to the section, “Creating, Changing and Deleting
Passwords” in Chapter 5. Follow the instructions for creating or changing a
password. Then return here for instructions on moving the jumper.

3. Go to Chapter 2, “Preparing the Workstation to Remove and Install a CPU and
Memory” on page 38, and follow the instructions through “Removing the System
Module.” After the system module is removed, return here for instructions on
enabling the password.

Note: The jumper is a small plastic cap that resides near the CPU. The jumper is on
the left side of the 3-pin configuration because the password was disabled by moving
the jumper to the left. To enable the password, you must move the jumper to the
right. Go to the next step for instructions on moving the jumper to the right.
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Figure 8-14 Removing the Jumper to Enable the Password

4. Locate the white rectangle printed on the system board at the base of the jumper.
The rectangle has “Disable passwd” beside it. The white rectangle surrounds the
jumper and one pin to the left of the jumper. The jumper is now disabled, and sits
on the on the left and middle pins.

5. Pull up on the jumper and remove it.

Caution - do not touch
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System Does Not Power Off
6. Place the jumper on the middle and right pins (within the rectangle). The password
is now enabled.

You have finished enabling the password and are ready to replace the system
module.

7. Return to Chapter 2, “Replacing the System Module” on page 59 and follow the
instructions through powering on the Octane workstation.

System Does Not Power Off

If the system does not power off, either it never came up all the way or the operating
system is hung. If you do not see any activity for several minutes, follow the steps below.

Figure 8-15 Pressing the Power Button

1. Press the power button again.

Note: If you press the power button a second time, the system powers off
immediately, but it is not a clean shutdown. Avoid using this method unless the
system does not respond for several minutes after your press the power button the
first time.

Power button

Reset button
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Figure 8-16 Pressing the Reset Button

2. If pressing the power button a second time does not work, use a pencil or pen to
press the reset button.

3. If the system still fails to power off, unplug the power cord from the back of the
workstation and contact your service provider.

Returning Parts

To return any part, use the packaging materials and box that came with your replacement
part.

For product support information, see the Introduction of this guide.

Power button

Reset button
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This appendix provides illustrations of XIO graphics boards that are available
for the Octane workstation.

Identifying Graphics Boards

Appendix A





Appendix A

A. Identifying Graphics Boards

This appendix provides illustrations of the Octane/SI or SE graphics board, Octane/SI
or SE graphics board with texture memory option board, Octane/SSI or SSE graphics
board, and Octane/MXI or MXE graphics board.

• “Octane/SI or SE Graphics Board” on page 281

• “Octane/SI or SE Graphics Board With the Texture Memory Option Board” on
page 282

• “Octane/SSI or SSE Graphics Board” on page 283

• “Octane/MXI or MXE Graphics Board” on page 284

Octane/SI or SE Graphics Board

Figure A-1 Octane/SI or SE Graphics Board

Connectors for texture
memory board

Cap on XIO compression
connector

Flex cable connectors
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Octane/SI or SE Graphics Board With the Texture Memory Option Board

Figure A-2 Octane/SI or SE Board With the Texture Memory Option Board

Connectors
beneath texture
memory board

Cap on XIO compression
connector

Flex cable connectorsTexture memory board
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Octane/SSI or SSE Graphics Board
Octane/SSI or SSE Graphics Board

Figure A-3 Octane/SSI or SSE Graphics Board

Flex cable connectors

Cap on
XIO compression
connector

Connectors for texture
memory boards 
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Octane/MXI or MXE Graphics Board

Figure A-4 Octane/MXI or MXE Graphics Board

Flex cable connectors

Connectors for texture
memory boards 

Cap on
XIO compression
connector

Texture memory boards
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This chapter provides information about the care and cleaning of the
compression connectors found on the system module, PCI module, all XIO
graphics boards, and most XIO option boards.

Care and Cleaning of the Compression
Connector
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B. Care and Cleaning of the Compression Connector

The Octane workstation uses compression connectors to connect several modules and
boards to the frontplane.

A single compression connector is used in the Octane workstation:

• on the back of the PCI module

• on each XIO board on the XIO module

Two compression connectors are used on the system module.

The compression connector has 96 pads that enable signals to pass between the system
(via the frontplane) and the system module, PCI module, or XIO board.

The compression connector has two halves: One half is located on the frontplane of the
chassis; the other, on the system module, PCI module, or XIO board. Each pad on a
frontplane connector is a flat gold-plated surface. Each pad on the system module, PCI
module, or XIO board is composed of hundreds of tiny bristles (dendrites). When a
bristled pad is pressed into a gold-plated pad, a connection is created for one signal.

Figure B-1 Identifying the Bristled Pad of the Compression Connector

The bristled pads may attract and hold dust, lint, grease, powder, and dirt. The presence
of these substances clogs or damages the bristles and prevents them from making proper
contact with the gold-plated pads on the system’s frontplane. It is important to prevent
this.

Bristled pad
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Guidelines for Storing and Handling the Compression Connector

To avoid damaging a compression connector and to keep it in optimal working
condition, follow these guidelines whenever the board is not installed.

Caution: Failure to follow these instructions can result in irreparable damage to the
surface of the connector’s pads, which may result in intermittent or complete failure of
the product.

• Do not wipe or touch the pads of the compression connector with anything (no
human fingers, no brushes, no cloth, no probes), except as specified in the cleaning
instructions. The bristles might be damaged.

• Whenever the module or board is not in the chassis, put the protective cap over the
compression connector and put the module or board in an antistatic bag. Make sure
to close (fold over) the open end of the bag to minimize exposure to dust and
atmospheric gases.

• Do not put anything (not even water) onto the pads, except as specified in the
cleaning instructions.

• Before laying the board on a surface, make sure that the surface is free of dust, lint,
powder, metal filings, oil, water, and so on.

• Do not blow dust, dirt, or powder anywhere near the board when it is not inside its
protective bag.

Guidelines for Cleaning the Compression Connector

A compression connector should never need to be cleaned if you keep the protective
cover on whenever the module or board is not in the chassis. However, if the connector
becomes dirty, follow the instructions below for removing pollutants.

Note: Some pollutants can irreversibly damage (corrode or chemically alter) the pad
surfaces. Although cleaning may remove the pollutant, it does not repair damage
incurred by this contact.
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Guidelines for Cleaning the Compression Connector
To remove pollutants, follow these instructions:

1. Obtain a can of dry compressed air or inert gas. The Envi-ro-tech Duster 1671
product manufactured by TECHSPRAY (In the USA, telephone 806-372-8523) works
extremely well for this application.

Caution: Do not use a cleaning product that contains any of the following
ingredients: halogenated hydrocarbons, aromatic hydrocarbons, ethers, sulfur,
ketones, or solvents of any kind. These substances cause irreparable damage to the
connector’s surface.

2. Prepare the can for use, as instructed on the can. For example, if a tube is provided,
attach it to the can’s dispensing mechanism.

Figure B-2 Spraying the Compression Connector
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3. Hold the can in a vertical position.

4. Place or hold the XIO board so that the rounded edge of the compression connector
faces up. Note that the rounded edge is completely closed, so that air cannot flow
into the connector, whereas the squared edge has an opening.

Caution: Spraying into the squared (open) edge of the connector can destroy it.

5. Position the XIO board at an angle to the can, so that the tip of the can’s applicator is
1 to 2 inches away from the first (topmost) row of pads. Do not allow the applicator
to touch the pads. When you spray, the air hits each pad and flows downward.

6. Start spraying. As you spray, move the spray along the length of the connector until
the entire length has been sprayed. Move down a few rows and again spray along
the entire length.

Note: Do not shake the can. Stop spraying if any visible material (for example, foam)
appears. This foam will blow away once you resume spraying just air.

7. Repeat until all the pads have been sprayed.

8. When you finish, cover the compression connector with its cap or immediately
install the board in an XIO slot.
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This chapter provides port pinout assignments for the external ports on the
Octane workstation. It also provides physical environment specifications for
the Octane workstation.

Technical Specifications
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C. Technical Specifications

To see the information in this appendix in a Web browser, enter the following URL in the
location window:

file:/usr/share/Insight/library/SGI_bookshelves/SGI_EndUser/books/
Octane_HWCntl/index.html

Or, access Octane Hardware Central from the Toolchest:

• IRIX 6.5 users: From the Toolchest > Help > InfoSearch, type Octane Hardware
Central.

• IRIX 6.4 users: From the Toolchest > Help > Online Books > SGI End User, choose
Octane Hardware Central.

Port Pinout Assignments

This section contains port pinout information for the following Octane ports:

• Audio ports

– microphone

– speaker

– analog line level audio

– coaxial digital audio

– optical digital audio

• “SCSI Port”

• “Ethernet 10-Base-T/100-Base-T Port”

• “Parallel Port”

• “Keyboard and Mouse Ports”

• “Serial Ports”
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• “Serial Cables and Adapters”

• “Monitor Port”

• “StereoView Port”

Audio Ports

Microphone Port

Table C-1 shows the port pinout information for the microphone.

Table C-1 Microphone Port Pinout

Microphone Tip Ring Sleeve

Silicon Graphics
supplied electret
mono microphone

Signal(+) Signal(+)
NC (no connection)

Ground(-)

Line level mono
microphone

Ground (-) Signal (+) Ground (-)

Signal (+)

Ground (-)
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Port Pinout Assignments
Speaker Port Pinout

Above is the port and plug pinout for the speaker/headphone port.

Above is the speaker power port and plug pinout.

Table C-3 shows the port pinout assignments for the speaker power port.

Table C-2 Speaker/Headphone Port Pinout

Speaker/Headphone Signal Tip Ring Sleeve

Left Right Ground

Table C-3 Speaker Power Port Pinout

Speaker Tip Sleeve

10 Volt DC

500 mA

Power (+) Ground

Signal (+)

Ground (-)

R

L

Ground (-)

+
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Analog Line Level Port Pinout

The pinouts for the analog audio ports and plugs are shown above.

Coaxial Digital Port Pinout

The port (jack) pinout for the coaxial digital ports and plugs are shown above.

Coaxial digital

• Supports the AES3id professional format.

• Compatible with consumer formats including CP340, IEC958, and S/PDIF.

Signal

Ground/returnGround/return
Signal

 IN

OUT

Red White

Right Left

Signal

Ground/returnGround/return
Signal

 IN OUT

Red White
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Optical Digital Port Pinout

An optical digital port is shown above.

• Supports ADAT 8-channel, 24-bit connections.

• Compatible with consumer formats including CP340, IEC958, and S/PDIF.
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SCSI Port

Table C-4 shows the cable pinout assignments for the SCSI port.

Table C-4 SCSI Port Pinout

Pin Assignment Pin Assignment

1 Ground 35 DB(12)

2 Ground 36 DB(13)

3 Ground 37 DB(14)

4 Ground 38 DB(15)

5 Ground 39 DB(P1)

6 Ground 40 DB(0)

7 Ground 41 DB(1)

8 Ground 42 DB(2)

9 Ground 43 DB(3)

10 Ground 44 DB(4)

11 Ground 45 DB(5)

12 Ground 46 DB(6)

13 Ground 47 DB(7)

14 Ground 48 DB(P)

15 Ground 49 Ground

34                 1

68 35
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16 Ground 50 Ground

17 Termpwr 51 Termpwr

18 Termpwr 52 Termpwr

19 Open 53 Open

20 Ground 54 Ground

21 Ground 55 ATN

22 Ground 56 Ground

23 Ground 57 BSY

24 Ground 58 ACK

25 Ground 59 RST

26 Ground 60 MSG

27 Ground 61 SEL

28 Ground 62 C/D

29 Ground 63 REQ

30 Ground 64 I/O

31 Ground 65 DB(8)

32 Ground 66 DB(9)

33 Ground 67 DB(10)

34 Ground 68 DB(11)

Table C-4 (continued) SCSI Port Pinout

Pin Assignment Pin Assignment
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Ethernet 10-Base-T/100-Base-T Port

The Octane workstation autoselects the speed and type (duplex vs. half duplex) at
bootup, based on what it is connected to.

Table C-5 shows the cable pinout assignments for the Ethernet 10-Base-T/100-Base-T
port.

Table C-5 Ethernet 10-BASE-T/100-BASE-T Port Pinout

Pin Assignment

1 Transmit+

2 Transmit–

3 Receive+

4 (Reserved)

5 (Reserved)

6 Receive–

7 (Reserved)

8 (Reserved)

1  2  3  4  5  6  7  8
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Port Pinout Assignments
Parallel Port

Table C-6 shows the cable pinout assignments for the IEEE 1284-C parallel port.

Table C-6 Parallel Port Pinout

Pin Assignment Pin Assignment

1 BUSY 19 Signal Ground (BUSY)

2 SELECT 20 Signal Ground (SELECT)

3 nACK 21 Signal Ground (nACK)

4 nFAULT 22 Signal Ground (nFAULT)

5 pERROR 23 Signal Ground (pERROR)

6 DATA 1 24 Signal Ground (DATA 1)

7 DATA 2 25 Signal Ground (DATA 2)

8 DATA 3 26 Signal Ground (DATA 3)

9 DATA 4 27 Signal Ground (DATA 4)

10 DATA 5 28 Signal Ground (DATA 5)

11 DATA 6 29 Signal Ground (DATA 6)

12 DATA 7 30 Signal Ground (DATA 7)

13 DATA 8 31 Signal Ground (DATA 8)

14 nINIT 32 Signal Ground (nINIT)

15 nSTROBE 33 Signal Ground (nSTROBE)

16 nSELECTIN 34 Signal Ground (nSELECTIN)

18   1

36 19
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Keyboard and Mouse Ports

This is a standard pinout for PC PS/2 keyboards and mice. The mouse and keyboard are
electrically PS/2 compatible. They also use the same protocol as the PC PS/2 keyboards
and mice.

Table C-7 shows the cable pinout assignments for the keyboard and mouse ports.

17 nAUTOFD 35 Signal Ground (nAUTOFD)

18 HOST LOGIC HIGH 36 view PERIPHERAL LOGIC HIGH

Table C-7 Keyboard and Mouse Port Pinout

Pin Assignment

1 Keyboard/Mouse Data

2 (Reserved)

3 Ground

4 Keyboard/Mouse Power (+5V)

5 Keyboard/Mouse Clock

6 (Reserved)

Table C-6 (continued) Parallel Port Pinout

Pin Assignment Pin Assignment

1

2

5

6

3

4
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Port Pinout Assignments
Serial Ports

The Octane workstation serial ports can operate in one of several modes:

• RS-232 electrical levels with a standard PC pinout.

• Macintosh style electrical levels and a Macintosh-compatible pinout. (This mode
requires an additional adapter cable. See “Serial Port Adapter Cables” on page 307.)

• ANSI/SMPTE 207M electrical levels and pinout. (This mode requires an additional
adapter cable. See “Serial Port Adapter Cables” on page 307.)

This the PC-compatible pinout. The range of supported baud rates is 300 baud to
460K baud.

Table C-8 shows cable pinout assignments for the serial ports.

Table C-8 Serial Port Pinout - PC-Compatible

Pin Assignment Description

1 DCD Data Carrier Detect

2 RD Receive Data

3 TD Transmit Data

4 DTR Data Terminal Ready

5 SG Signal Ground

6 DSR Data Set Ready

7 RTS Request to Send

1
2
3
4
5

6
7
8
9
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This is the Macintosh-compatible pinout.

Table C-9 shows cable pinout assignments for the serial ports.

Serial Cables and Adapters

This section contains cable pinout information for serial cables that you can connect to
your Octane workstation. It also describes Silicon Graphics serial port converters. The
following topics are covered:

• “Printer/Dumb Terminal Serial Cable”

• “PC Modem Serial Cable”

• “Serial Port Adapter Cables”

8 CTS Clear to Send

9 RI Ring Indicator

Table C-9 Serial Port Pinout - Macintosh-Compatible

Pin Assignment Description

1 GPi General Purpose Input

2 RxD- Receive Data-

3 TxD- Transmit Data -

4 TxD+ Transmit Data +

5 SG Signal Ground

6 RxD+ Receive Data +

7 HSKo Handshake Out

8 HSKi Handshake In

9 Unused

Table C-8 (continued) Serial Port Pinout - PC-Compatible

Pin Assignment Description
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Printer/Dumb Terminal Serial Cable

For serial printers and dumb terminals, use a 3-wire standard PC cable. Table C-10 shows
the cable connector pinout assignments for this cable.

Note: For a 3-wire cable and no hardware flow control modem, you must use the
/dev/ttyd* command devices in the configuration files. For more detailed information, see
the serial man page. To access the man page, from the Toolchest, choose Help >
InfoSearch > Man pages. Or place the cursor in the console window and type

man serial

PC Modem Serial Cable

Use a full-handshake (includes RTS and CTS) PC modem serial cable for a modem with
RTS/CTS flow control. Table C-11 shows the cable connector pin assignments for this
cable.

Table C-10 Printer/Dumb Terminal Cable Pinout

Signal
Description

Pin Number
DB9 Connector (Female)

Pin Number
DB-25 Connector (Male)

1 NOT CONNECTED

RXD 2 2

TXD 3 3

4 NOT CONNECTED

GND 5 7

6 NOT CONNECTED

7 NOT CONNECTED

8 NOT CONNECTED

9 NOT CONNECTED
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You can use this cable for all serial devices except those that do not need RTS flow control.
Devices like serial printers and dumb terminals that do not need RTS flow control can
still be used with this cable provided that a null modem adapter is added to one end of
the cable. You can purchase the full-handshake PC modem serial cable from Silicon
Graphics or your local service provider.

Note: If you are attaching a modem with modem signals and RTS/CTS flow control, you
must use the /dev/ttyf* command devices in the configuration files. For more detailed
information, see the serial man page. To access this man page, from the Toolchest, choose
Help > InfoSearch > Man pages. Or place the cursor in the console window and type

man serial

Table C-11 PC Modem Cable Pinout

Signal
Description

Pin Number
DB9 Connector (Female)

Pin Number
DB-25 Connector (Male)

DCD 1 8

RXD 2 3

TXD 3 2

DTR 4 20

GND 5 7

DSR 6 6

RTS 7 4

CTS 8 5

RI 9 22
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Serial Port Adapter Cables

The Octane workstation’s serial ports conform to the PC standard pinout for EIA
standard RS-232 signals.

The purpose of the adapter cable is to allow the Octane workstation to use standard PC
or Macintosh serial devices.

Table C-12 shows the adapter cable pinout for a standard PC or Macintosh serial port.

The purpose of the following adapter cable is to support ANSI/SMPTE Standard
107M-1992.

Table C-12 Female DB9 to Female MiniDIN8 Adapter Cable Pinout

From

Female DB9

To

MiniDIN8

PC Signal Macintosh Signal

1 7 DCD GPi

2 5 RD RxD-

3 3 TD TxD-

4 1 DTR TxD+

5 4 SG SG

6 8 DSR RxD+

7 6 RTS HSKo

8 2 CTS HSKi

9 unused RI unused
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Table C-13 shows the pinout for a female DB9 to female DB9 adapter cable.

Note: For more detailed information, see the serial man page. To access it, place the
cursor in an IRIX shell and enter

man serial

Or, access Man Pages through the Toolchest > Help or in the InfoSearch window, enter

man serial

Table C-13 Female DB9 to Female DB9 Adapter Cable Pinout

Female DB9 Connected to Octane Female DB9 Connected to Peripheral

1 unused

2 to DB9 -2 (RxD-)

3 to DB9-8 (TxD-)

4 unused

5 to DB9-6and DB9-4 (GND)

6 to DB9-7 (RxD+)

7 to DB9-3 (TxD+)

8 unused

9 unused
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Ports on XIO Graphics Boards

Monitor Port

Table C-14 shows the port pinout assignments for the Octane 20 inch monitor. Table C-15
shows the port pinout assignments for an Octane DDC enabled monitor.

Table C-14 20 Inch Monitor Pinout

Pin Assignment

A1 Red Signal, Analog

A2 Green Signal, Analog

A3 Blue Signal, analog

1 Monitor ID Bit 3, TTL

2 Monitor ID Bit 0, TTL

3 Composite Sync (Active Low), TTL

4 Horizontal Drive (Active High), TTL

5 Vertical Drive (Active High), TTL

6 Monitor ID Bit 1, TTL

7 Monitor ID Bit 2, TTL

8 Ground

9 Ground

10 Ground

A1 1 2 3 4 5 A2 A3

6 7 8 9 10
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StereoView Port

Table C-15 DDC Enabled Monitor Pinout

Pin Assignment - DDC Enabled

A1 Red

A2 Green

A3 Blue

1 Data Clock (SCL)

2 Bi-directional Data (SDA)

3 Composite Sync

4 Horizontal Sync

5 Vertical Sync

6 DDC (+5VInput)

7 DDC Ground

8 Chassis Ground

9 Chassis Ground

10 Chassis Ground

5

4

3

2

1

9
8
7
6
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Physical Environment Specifications
Table C-16 shows the cable pinout assignments for the StereoView port on the graphics
boards.

Physical Environment Specifications

Table C-17 shows the physical environent specifications for the Octane workstation.

Table C-16 StereoView Pinout Assignments

Pin Assignment

1 Stereo left/right Eye Signal (1=left, 0=right) (STEREO_LEFT)

2 Signal Return Ground

3 Reserved for Future Use

4 Signal Return Ground (Framelock ground)

5 Reserved for Future Use (Framelock)

6 Digital Return Ground

7 Digital Return Ground for StereoView

8 +12V DC Output to StereoView Device

9 Unused

Table C-17 Physical Environment Specifications

Workstation dimensions 16.25” (41.3 cm) H x 11.0” (28 cm) W x 13.25”
(33.7 cm) D

14.75” D (37.5 cm) (depth in localized area of
power supply)

16.25” D (41.3 cm) (depth in localized area of
optional PCI module)

Power Requirements Voltage and frequency: 100-240 VAC, 50-60 Hz,
10-4.2A, 850W

Ambient Temperature +13o C (23.4o F) to +35o C (95o F) (operating)

-10o C (14o F) to +65o C (149o F) (non-operating)
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Microphone Specifications

Table C-18 shows microphone specifications.

Relative Humidity 10% to 80% operating (no condensation)

10% to 95% non-operating (no condensation)

Heat Dissipation 700 watts, 2400 Btu/hr

Altitude 10,000 ft. (3,049 m) operating;

40,000 ft. (12,195 m) non-operating

Vibration 0.02’, 5-19Hz; 0.35 G, 19-500 Hz

Voltage and frequency 100-120/200-240 VAC

Table C-18 Microphone Specifications

Microphone Jack

Connector 3.5 mm stereo mini

Power +5 V phantom power on tip

Type Unidirectional electret condenser

Table C-17 (continued) Physical Environment Specifications

Workstation dimensions 16.25” (41.3 cm) H x 11.0” (28 cm) W x 13.25”
(33.7 cm) D

14.75” D (37.5 cm) (depth in localized area of
power supply)

16.25” D (41.3 cm) (depth in localized area of
optional PCI module)
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Physical Environment Specifications
Speaker Specifications

Table C-19 shows speaker specifications.

Headphone Specifications

Table C-20 shows headphone specifications.

Analog Line Level Audio Specifications

Table C-21 provides Analog audio line level specifications.

Table C-19 Speaker Specifications

Speakers

Rated power 3 W(average) per channel

Frequency range 180 Hz - 15K Hz

Magnetic flux leakage <50 mGauss @2 cm

Input impedance 150 ohms

Signal connector 3.5 mm stereo mini

Power connector 2.5 mm mono micro

Table C-20 Headphone Specifications

Headphones

Recommended impedance 35 ohms

Connectors 3.5 mm stereo mini

Table C-21 Analog Line Level Specifications

Specifications Line In Line Out

Line level -10dBV -10dBV

0dBFS Maximum +10dBV to -22dBV 6.5dBV ± 0.5dBV
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PCI Module Power Specification

Total power for the PCI module (the sum of power for all boards from all power supply
rails) must not exceed 45.0W (average 15.0W per board).

The Octane PCI module is a 5V system environment.

Note: For additional information see Section 4.3.4.1, in the chapter called “Power
Requirements,” in the PCI Local Bus Specification, Rev. 2.1, June l995 (PCI Special Interest
Group, Portland, OR).

Table C-22 PCI Module Power Specifications

Power Supply Rail Maximum Current Maximum Power

3.3V 10.0A 33.0W

5.0V 9.0A 45.0W

12.0V 1.5A 12.0W

-12.0V 0.3A 3.6W
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Appendix D

D. Creating a System Disk From the PROM Monitor

This appendix describes how to create a system disk from an option disk and install an
operating system. It describes how to install a system disk on a system that does not
currently have a working system disk. It is used in these situations:

• The new disk has no formatting or partitioning information on it at all or the
partitioning is incorrect.

• It is an option disk that you must turn into a system disk.

To turn a disk into a system disk, you must have an IRIX system software release CD
available and a CD-ROM drive attached to the system or available on the network. If you
are using a CD-ROM drive attached to a system on the network, that system must be set
up as an installation server. See the IRIX Admin: Software Installation and Licensing guide
for instructions.

These instructions assume that the system disk is installed on controller 0 at drive
address 1. This is the standard location for workstations; the controller number is
system-specific on servers. Follow these steps:

1. Bring the system up into the System Maintenance menu.

2. Bring up the Command Monitor by choosing the item 5 on the System Maintenance
menu.

3. Give the hinv command and use the CPU type to determine the version of
standalone fx that you need to invoke. For example, a system with an IP30
processor is an ARCS processor, so the version of standalone fx needed is
stand/fx.64.

4. Determine the controller and drive address of the device that contains the copy of fx
that you plan to use (a CD-ROM drive attached to the system or a CD-ROM drive
on a workstation on the network). For example, for a local CD-ROM drive, if hinv
reports that the CD-ROM drive on the system is scsi(1), cdrom(4), the controller is 1
and the drive address is 4. The remainder of this example uses that device, although
your device may be different or may be located on a different workstation.
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5. If you are installing over a network connection, get the IP address and host name of
the workstation with the CD-ROM drive, then skip to step 8. If you are not
installing over a network connection, go to the next step.

6. Insert the CD containing the IRIX system software release into the CD-ROM drive.

7. Give a Command Monitor command to boot fx. For this example the command is:

>> boot -f dksc(1,4,8)sash64 dksc(1,4,7)stand/fx.64 --x
72912+9440+3024+331696+23768d+3644+5808 entry: 0x89f9a950
112784+28720+19296+2817088+59600d+7076+10944 entry: 0x89cd74d0
SGI Version6.4 ARCS Jan 31, 1997

Caution: The fx command is intended for advanced users and should not be used
unless you have a definite need for it. Refer to the fx(1) man page for complete
information on using fx.

Go to step 10.

Note: See “Preliminary PROM Monitor Procedure” for details on how to enter the
command monitor on your system.

8. Invoke fx from the standalone version on your workstation, or from a local or
remote CD-ROM. See the fx(1M) man page for complete instructions on invoking
fx, or use the following procedure.

• To invoke the standalone copy of fx on your workstation, enter

>> boot stand/fx --x

• To invoke fx from a CD with installation tools in a CD-ROM drive on your
workstation, enter this command:

>> boot -f dksc(cntlr,unit,8)sash64 dksc(cntlr,unit,7)stand/fx.64 --x

In the previous command, cntlr and unit are the controller and unit numbers of
the CD-ROM drive (see “Getting CD-ROM Device Numbers”).

• To invoke fx from a CD with installation tools that is mounted on an installation
server named server, enter this command:

>> boot -f bootp()server:CDdir/stand/fx.64 --x

In the previous command, CDdir is the mount point directory for the CD (for
example, /CDROM).
318



9. After fx is invoked, messages, prompts, and menus appear. A sample session is
shown. In this sample session, the default system disk device name, controller
number, and drive number chosen by fx (dksc, 0, and 1, respectively) are used.
Unless your workstation is configured in a non-standard way, the defaults chosen
by fx will be correct and you can respond with Enter to the prompts.

10. Respond to the prompts by pressing the Enter key. These responses select the
system disk:

fx: “device-name” = (dksc) <Enter>
fx: ctlr# = (0) <Enter>
fx: drive# = (1) <Enter>
...opening dksc(0,1,)
...drive selftest...OK
Scsi drive type == SGI     SEAGATE ST31200N8640

----- please choose one (? for help, .. to quit this menu)-----
[exi]t             [d]ebug/           [l]abel/           [a]uto
[b]adblock/        [exe]rcise/        [r]epartition/     [f]ormat

11. Display the partitioning of the disk by giving the repartition command:

fx> repartition

----- partitions-----
part type blocks Megabytes (base+size)
7: efs        4 + 2722     3048 + 2074164
8: volhdr     0 + 4        0 + 3048
10: volume    0 + 2726     0 + 2077212

capacity is 2077833 blocks

If what you see looks like the examples in number 11 above, you need to repartition.
If the disk doesn’t need repartitioning, skip the rest of the procedures.

For a custom installation, use a powered-on Silicon Graphics system to access the
Toolchest > Help > Online Books > SGI_Admin > IRIX Admin: Disks and Filesystems,
or find a printed copy of this guide.
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12. Choose a standard system disk partition layout. Follow these directions:

Choose rootdrive.

----- please choose one (? for help, .. to quit this menu)-----
[ro]otdrive        [o]ptiondrive       [e]xpert
[u]srrootdrive    [re]size
fx/repartition> rootdrive

fx/repartition/rootdrive: type of data partition = (xfs) <Enter>

You see the following warning message:

Warning: You will need to re-install all software and restore user data from
backups after changing the partition layout. Changing partitions will cause all
data on the drive to be lost. Be sure you have the drive backed up if it contains any
user data. Continue?

13. Enter ‘Yes’ or ‘No’ after the warning message.

Yes   or No

If you choose yes, you see the following:

----- partitions-----
part type blocks Megabytes (base+size)
0: xfs             3024 + 1976184              1 + 965
1: raw             1979208 + 81648             966 + 40
8: volhdr          0 + 3024                    0 + 1
10: volume         0 +2060856                  0 + 1006

capacity is 2061108 blocks

The above numbers vary depending on the size of the drive.

To exit fx and go back to the System Maintenance Menu, enter
‘../exit’ at the fx prompt as shown below:

----- please choose one (? for help, .. to quit this menu)-----
[ro]otdrive       [o]ptiondrive       [e]xpert
[u]srrootdrive        [r]esize
fx/repartition> ../exit

See “Installing a New Version of the Operating System” on page 321 for instructions on
completing your task.
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Installing a New Version of the Operating System
Installing a New Version of the Operating System

After creating a new system disk, you must install a new version of the operating system.
For instructions, see the Installation Instructions booklet that came with your operating
system CDs.
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Appendix E

E. Regulatory Information

Manufacturer’s Regulatory Declarations

The Octane workstation conforms to several national and international specifications
and European Directives listed on the “Manufacturer’s Declaration of Conformity.” The
CE insignia displayed on each device is an indication of conformity to the European
requirements.

Caution: Your workstation has several governmental and third-party approvals,
licenses, permits. Do not modify this product in any way that is not expressly approved
by Silicon Graphics. If you do, you may lose these approvals and your governmental
agency authority to operate this device.

CMN Number

The model number, or CMN number, for the Octane workstation is on the system label
on the back of the workstation. The system label is located at the top and middle of the
workstation. See “Back View” on page 6 for the location of your system label.

You need to know the CMN number for downloading the Manufacturer’s Declaration of
Conformity from the World Wide Web. You also need to know the CMN number to
determine the class of your Octane workstation. Match the CMN number on the back of
your workstation with the CMN number on the Class A FCC Declaration of
Conformance or Class B FCC Declaration of Conformance on the following pages. The
model number for Class A begins “CMNB015A” and the model number for Class B
begins “CMNB015B.”
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Manufacturer’s Declaration of Conformity

A “Manufacturer’s Declaration of Conformity” is available on the World Wide Web.
Look on your system (regulatory) label on the rear of your workstation to determine your
CMN (model) number, which you need to identify your Declaration of Conformity. See
“Back View” on page 6 for the location of your system label.

To locate the information on the World Wide Web, enter the following in your Web
browser location window:

http://www.sgi.com/compliance/index.html

Regulatory Label

Follow the steps below for placement of upgrade regulatory labels.

1. If you received a system upgrade label, place it on the system label.

■ Face the back of the Octane workstation. The system label is located at the top
center of the back of the workstation. See “Back View” on page 6.

■ Place the system upgrade label over the lower right portion of the system label,
over the VCCI and SISPR 22 information.

2. If you received a regulatory label with a processor upgrade, place it on the label
between the fan and PCI module, in the middle of the back of the workstation. See
“Back View” on page 6.

• Place the CPU upgrade label over “CPU Upgrade 1,” if it is the first CPU
upgrade to the base system.

• If the CPU upgrade is a second or third upgrade, place the label in the
appropriate location; over “CPU Upgrade 2” or “CPU Upgrade 3.”
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Class A
Class A

This equipment complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause
undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a commercial environment. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instruction manual, may cause harmful interference to
radio communications. Operation of this equipment in a residential area is likely to cause
harmful interference, in which case the user will be required to correct the interference at
his own expense.

If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Caution: The user is cautioned that changes or modifications to the equipment not
expressly approved by the party responsible for compliance could void the user’s
authority to operate the equipment.

Electromagnetic Emissions

The following information applies to the workstation base configuration. Refer to the
Manufacturer’s Declaration of Conformity for your workstation’s specific classification,
which may be different from the base configuration. For details, refer to “Manufacturer’s
Declaration of Conformity” on page 326 of this appendix.
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This device complies with the Class A limits of Part 15 of the FCC Rules. Operation is
subject to the following two conditions:

• This device may not cause harmful interference.

• This device must accept any interference received, including interference that may
cause undesired operation.

This Class A digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.

Cet appareil numérique német pas de perturbations radioélectriques dépassant les
normes applicables aux appareils numériques de Classe A préscrites dans le Règlement
sur les interferences radioélectriques établi par le Ministère des Communications du
Canada.

This device complies with Class A electromagnetic emissions limits of C.I.S.P.R.
Publication 22, Limits and Methods of Measurement of Radio Interference
Characteristics of Information Technology Equipment; and Japan’s VCCI Class A limits.

Chinese Statement

Japanese Statement
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Korean Statement

Radio and Television Interference

The equipment described in this guide generates and uses radio frequency energy. If it is
not installed and used in accordance with the instructions in this guide, it can cause radio
and television interference.

This equipment has been tested and complies with the limits for a Class A computing
device in accordance with the specifications in Part 15 of FCC rules. These specifications
are designed to provide reasonable protection against such interference in an industrial
or office installation. However, there is no guarantee that the interference will not occur
in a particular installation. This system is not certified for home use.

You can determine whether your system is causing interference by turning it off. If the
interference stops, it was probably caused by the workstation or one of the peripherals.
To tell if the interference is caused by one of the peripherals, try disconnecting one
peripheral at a time to see if the interference stops. If it does, that peripheral is the cause
of the interference.

If your workstation does cause interference to radio or television reception, try to correct
the interference by using one or more of the following suggestions:

• Turn the television or radio antenna until the interference stops.

• Move the workstation to one side or the other of the radio or television.

• Move the workstation farther away from the radio or television.

• Plug the workstation into an outlet that is on a different circuit from the radio or
television. (That is, make certain the workstation and the radio or television are on
circuits controlled by different circuit breakers or fuses.)

• For additional information you can check the FCC Web site by entering the
following address in your Web browser location window:

http://www.fcc.gov/Bureaus/Compliance/WWW/tribook.html
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Shielded Cables

The Octane workstation is FCC-compliant under test conditions that include the use of
shielded cables between Octane and its peripherals. Your Octane workstation and any
peripherals you purchase from Silicon Graphics have shielded cables. Shielded cables
reduce the possibility of interference with radio, television, and other devices. If you use
any cables that are not from Silicon Graphics, make sure they are shielded. Telephone
cables do not need to be shielded.

The monitor cable supplied with your system uses additional filtering molded into the
cable jacket to reduce radio frequency interference. Always use the cable supplied with
your system. If your monitor cable becomes damaged, a replacement cable should be
obtained from Silicon Graphics.

Electrostatic Discharge

Silicon Graphics designs and tests its products to be immune to the effects of electrostatic
discharge (ESD). ESD is a source of electromagnetic interference and can cause problems
ranging from data errors and lockups to permanent component damage.

It is important that while you are operating your Octane you keep all the covers and
doors, including the plastics, in place. The shielded cables that came with the
workstation and its peripherals should be installed correctly, with all thumbscrews
fastened securely.

An ESD wrist strap is included with some products, such as memory and graphics
upgrades. The wrist strap is used when installing these upgrades to prevent the flow of
static electricity, and it should protect your system from ESD damage.
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Class B

This equipment complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause
undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

FCC Declaration of Conformance

Trade Name Silicon Graphics, Inc.

Product Computer Graphics Workstation

Model Number CMNB015B

Date of Conformance 1/97

Responsible Party Silicon Graphics, Inc.

Address 2011 North Shoreline Boulevard
Mountain View, California
94043-1389

Telephone (650) 933-1071
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Caution: The user is cautioned that changes or modifications to the equipment not
expressly approved by the party responsible for compliance could void the user’s
authority to operate the equipment.

Electromagnetic Emissions

The following information applies to the workstation base configuration. Refer to the
Manufacturer’s Declaration of Conformity for your workstation’s specific classification,
which may be different from the base configuration. For details, refer to “Manufacturer’s
Declaration of Conformity” on page 326 of this appendix.

This device complies with the Class B limits of Part 15 of the FCC Rules. Operation is
subject to the following two conditions:

• This device may not cause harmful interference.

• This device must accept any interference received, including interference that may
cause undesired operation.

This Class B digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.

Cet appareil numérique német pas de perturbations radioélectriques dépassant les
normes applicables aux appareils numériques de Classe A préscrites dans le Règlement
sur les interferences radioélectriques établi par le Ministère des Communications du
Canada.

This device complies with Class B electromagnetic emissions limits of C.I.S.P.R.
Publication 22, Limits and Methods of Measurement of Radio Interference
Characteristics of Information Technology Equipment; and Japan’s VCCI Class B limits.
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Class B
Japanese Statement

Korean Statement

Shielded Cables

The Octane workstation is FCC-compliant under test conditions that include the use of
shielded cables between Octane and its peripherals. Your Octane workstation and any
peripherals you purchase from Silicon Graphics have shielded cables. Shielded cables
reduce the possibility of interference with radio, television, and other devices. If you use
any cables that are not from Silicon Graphics, make sure they are shielded. Telephone
cables do not need to be shielded.
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The monitor cable supplied with your system uses additional filtering molded into the
cable jacket to reduce radio frequency interference. Always use the cable supplied with
your system. If your monitor cable becomes damaged, a replacement cable should be
obtained from Silicon Graphics.

Electrostatic Discharge

Silicon Graphics designs and tests its products to be immune to the effects of electrostatic
discharge (ESD). ESD is a source of electromagnetic interference and can cause problems
ranging from data errors and lockups to permanent component damage.

It is important that while you are operating your Octane you keep all the covers and
doors, including the plastics, in place. The shielded cables that came with the
workstation and its peripherals should be installed correctly, with all thumbscrews
fastened securely.

An ESD wrist strap is included with some products, such as memory and graphics
upgrades. The wrist strap is used when installing these upgrades to prevent the flow of
static electricity, and it should protect your system from ESD damage.
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Glossary

account

See login account.

active window

The only window that recognizes input (activity) from the keyboard and mouse; only
one window is active at a time.

ADAT optical interface

The ADAT optical interface provides a unidirectional point-to-point connection of 8
tracks of 24-bit digital audio, with subcodes, at professional sampling rates, on a single
consumer-grade optical fiber. A typical use is for a data connection between multiple
ADAT tape decks, for bouncing tracks between decks.

address dial

See SCSI address dial.

administrator

See system administrator and network administrator.

AES3

The AES3-1992 specification of transmission format for digital audio data. This
specification is also commonly referred to as AES/EBU. See also ANSI S4.4-1992 and
IEC958, Audio Engineering Society, Inc., Vol. 40, No. 3, 1992, New York, NY 10165. For
more information on this specification, see http://www.aes.org/publications/.

AES3id

An information document describing implementation of AES3-1992 (see above
attribution) using 75-ohm coaxial cable with 1 V peak-to-peak signal levels. See
http://www.aes.org/publications/.

back up

To copy files and directories from your hard disk to a tape.
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backup tape

A tape that contains a copy of files and directories that are on your hard disk. A full
backup tape contains a copy of all files and directories, including IRIX, that are on your
hard disk.

baud rate

The speed (calculated as bits per second) at which the computer sends information to a
serial device, such as a modem or terminal.

bezel

The frame that holds the front cover. It attaches to the front of the chassis.

blank panel

A piece of plastic or metal covering openings in the chassis. A blank panel may be in front
of an empty drive bay, an empty graphics board slot, and empty PCI module opening, or
an empty PCI slot.

boot

To start up the system by turning on the workstation and monitor; the system is fully
booted when you see the console login: prompt or the login screen.

button

On a mouse, a button is a switch that you press with your finger. In a window on your
screen, a button is a labeled rectangle that you click using the cursor and mouse.

CD-ROM (CD)

A flat metallic disk that contains information that you can view and copy onto your own
hard disk; you cannot change or add to its information. CD-ROM is short for compact disc
read-only memory.

chassis

The exterior metal framework of the workstation that contains its working parts.

choose

Press the left mouse button to bring up a popup menu, move the cursor to highlight the
command that you want to run, then release the button.
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click

Hold the mouse still, then press and immediately release a mouse button.

compression connector

A specialized connector with two halves. One half of each connector resides on the
frontplane. The other half resides on the module or XIO board to which it is attached: the
system module, the PCI module, or the XIO graphics or option boards.The connector on
the frontplane has pads, the connector on the module or board side has bristles. The
compression connector must always be covered when a board or module is out of the
Octane workstation. It is easily damaged. See “Guidelines for Cleaning the Compression
Connector” in Appendix B.

compression connector cap

A cap that fits over a compression connector and protects it from being damaged by dust,
finger oil, scratches, dents, and so on. The cap must be on a compression connector
attached to a module or XIO board whenever the board or module is out of the Octane
workstation.

configuration file

A system file that you change to customize the way your system behaves. Such files are
sometimes referred to as customization files.

confidence test

A test that you run to make sure a particular device (such as the keyboard, mouse, or
drive) is set up and working properly.

connector

Hardware at the end of a cable that lets you fasten the cable to an outlet, port, or other
connector. A connector can also be on a PCI or graphics board and attaches to a connector
on the end of a cable.

console window

The window that appears as a stowed icon each time you log in; IRIX reports all status
and error messages to this window.

CPU board

The printed circuit board within your workstation chassis that contains the central
processing unit and its associated cache memory. The processor board plugs into the
system module in the Octane workstation.
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current working directory

The directory within the filesystem in which you are located when you are working in a
shell window.

cursor

The small arrow or other shape on the screen that follows the movements of the mouse.
It may change shape depending on its location on the screen.

DAT

Digital Audio Tape. A magnetic tape from which you can read and to which you can copy
audio and digital media.

dBV

Decibels relative to 1Vrms. To calculate the dBV value for “x” Vrms, use 20log10(x/1Vrms).

default printer

The printer to which the system directs a print request if you do not specify a printer
when you make the request. You set the default printer using the Print Manager.

defaults

A set of behaviors that Silicon Graphics specifies on every system. You can later change
these specifications, which range from how your screen looks to what type of drive you
want to use to install new software.

diagnostics

A series of tests that check the hardware components of your system.

DIMM

Dual inline memory module (DIMM). A small printed circuit board with DRAM
(dynamic random access memory) chips. DIMMs are made in a variety of types and
densities. Only one type and density can be used in a DIMM bank.

DIMM socket

A long thin female connector located on the system board into which you insert a DIMM.

directory

A special file in the filesystem in which you store other directories and files.
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disk resource

Any disk (hard, tape, CD-ROM, or floppy) that you can access either because it is
physically attached to your workstation with a cable or because it is available over the
network using NFS.

disk use

The percentage of space on your disk that contains information.

double-click

Hold the mouse still, then press and release a button twice, very rapidly. When you
double-click an icon, it opens into a window; when you double-click the window Menu
button, the window closes.

drag

Press and hold down a mouse button, then move the mouse. This action drags the cursor
to move icons or to highlight menu items.

drive

A hardware device that lets you access information on various forms of media, such as
hard and floppy disks, CD-ROM disks, and magnetic tapes.

drive address

See SCSI address.

export

To use NFS software to make all or part of your filesystem available to other users and
systems on the network.

external device

Any piece of hardware that is attached to the workstation with a cable.

female connector

A connector that has indentations or holes into which you plug a male connector. An
example of a female connector is an electrical wall outlet that accepts an electrical plug.

field

An area in a window in which you can enter text.
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file

A set of disk blocks in which you store information such as text, programs, or images that
you created using an application.

filesystem

A hierarchy of directories and files. Directories contain other directories and files; files
cannot contain directories. The root (/) directory is at the top of the hierarchy.

form

A window containing buttons that you must click and/or editable fields in which you
must enter text.

frontplane

The circuit board that connects PCI and XIO boards to the system board.

GB (gigabyte)

The abbreviation for a standard unit for measuring the information storage capacity of
disks and memory; 1,024,000 megabytes make one gigabyte, in most cases.

graphics board

The printed circuit board within your workstation that contains the graphics processors.
Graphics boards reside on the XIO module.

grounded electrical outlet

An electrical wall outlet that accepts a plug with a grounding prong. In the U.S.A., all
three-prong outlets are grounded.

handshake

The protocol that controls the flow of information between a workstation and a printer.

highlight

To change the color of an item on the screen by positioning the cursor over it
(locate-highlight), or by positioning the cursor over it and pressing a mouse button.

home directory

The directory into which IRIX places you each time you log in. It is specified in your login
account; you own this directory and, typically, all its contents.
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host

Any system connected to the network.

hostname

The name that uniquely identifies each host (system) on the network.

human factors guidelines

A set of standards and suggestions for making your physical working environment more
comfortable and healthy.

icon

A small picture that represents a stowed or closed file, directory, application, or IRIX
process.

InfoSearch

The Silicon Graphics online search tool that finds information by keyword, topic, or task.
InfoSearch seeks information in all information sources: man (reference) pages, online
books, application help, release notes, and task cards. InfoSearch is located in the
Toolchest.

internal drive

A drive that fits inside the workstation and connects to an internal port; it is never
connected with a cable to a visible external port. An internal drive is occasionally referred
to as a front-loading drive.

I/O

Input/output. Used in reference to input/output signals to/from graphics/XIO boards
or PCI boards.

IP address

A number that uniquely identifies each host (system) on a TCP/IP network.

IRIX

The Silicon Graphics version of the UNIX operating system. See also system software.

jot

A mouse- and window-based text editor that is included as part of the IRIX operating
system.
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KB (kilobyte)

The abbreviation for a standard unit for measuring the information storage capacity of
disks and memory (RAM and ROM); 1024 bytes make one kilobyte, in most uses.

launch

To start up an application, often by double-clicking an icon.

LED

Light-Emitting Diode. A light on a piece of hardware that indicates status or error
conditions.

local workstation

The physical workstation whose keyboard and mouse you are using, all hardware that is
connected to that workstation, and all software that resides on that hardware or its
removable media.

lockbar

A long piece of metal with a hole on the end that you slide through the chassis. It allows
you to secure the workstation with a lock and locking cable. The drives, frontplane,
system module (containing the CPU and DIMMs) are inaccessible when the lockbar is
locked in the system.

log in

To give the system your login name so you can start a session on the workstation.

log out

To end a session on the workstation.

login account

A database of information about each user that, at the minimum, consists of the login
name, user ID, and home directory.

login name

A name that uniquely identifies a user to the system.

login screen

The window that you see after powering on the system, before you can access files and
directories. The window contains one icon for each login account on the system.
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male connector

A connector that has raised edges, pins, or other protruding parts that you plug into a
female connector. An example of a male connector is an electrical plug that you plug into
a wall outlet.

man (manual) page

An online document that describes how to use a particular IRIX command. Also called
reference page.

MB (megabyte)

The abbreviation for a standard unit for measuring the information storage capacity of
disks and memory (RAM and ROM); 1024 kilobytes make one megabyte, in most uses.

menu

A list of operations or commands that the workstation can carry out on various objects
on the screen.

monitor

A hardware device that displays the images, windows, and text with which you interact
to use the system. It is also called a video display terminal (VDT).

monitor cable

The cable that connects the monitor to the workstation to transmit video signals.

monitor power cable

The cable that connects the monitor to the workstation to provide power to the monitor.
It is thick, with a male connector on one end and a female connector on the other.

mount

To make a filesystem that is stored on a local or remote disk resource accessible from a
specific directory on your workstation.

mount point

The directory on your workstation from which you access information that is stored on
a local or remote disk resource.
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mouse

A hardware device that you use to communicate with windows and icons. You move the
mouse to move the cursor on the screen, and you press its buttons to initiate operations.

mouse pad

For an optical mouse, this is the rectangular, metallic surface that reads the movements
of the mouse. For a mechanical mouse, this is a clean, smooth, rectangular surface that
makes the mouse’s track ball roll efficiently.

NEdit

NEdit is a graphical user interface (GUI) text editor. NEdit provides all the standard
menu, dialog, editing, and mouse support found in modern GUI-based environments.

network

A group of computers and other devices (such as printers) that communicate with each
other electronically to transfer and share information.

network administrator

The individual(s) responsible for setting up, maintaining, and troubleshooting the
network, and for supplying setup information to system administrators of each system.

notifier

A form that appears on the monitor when the system requires that you confirm an
operation that you just requested, or when an error occurs.

open

To double-click an icon, or to select an icon, then choose Open from a menu to display a
window that contains the information that the icon represents.

option drive

Any drive other than the system disk. Option drives include floppy disk drives,
secondary hard disk drives, or DAT drives.

outlets

Openings in the hardware to which you attach connectors to make an electrical
connection.

parallel port

An outlet on the workstation to which you connect external printers and similar devices.
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password

A combination of letters and/or numbers that only you know; it is analogous to a key
and prevents unauthorized access to your system. It is an optional element of your login
account. If you specify a password for your account, you must type it after you type your
login name before the system lets you access files and directories.

pathname

The list of directories that leads you from the root (/) directory to a specific file or
directory in the filesystem.

PCI

Peripheral Component Interconnect—a bus specification. The PCI bus is a
high-performance local bus used to connect peripherals to memory and a
microprocessor. A wide range of vendors make devices that plug into the PCI bus.

PCI I/O blank panel

A metal panel that fits on a slot in the I/O door. It must be in place if a PCI board is not
installed in the corresponding slot in the PCI module.

peripheral

A hardware device that adds more functionality to the basic workstation, such as a tape
drive. See also external device and internal drive.

port

An outlet to which you attach cable connectors.

power cable

The cable that connects the workstation to a grounded electrical outlet.

power off

To turn off the power switches on the workstation chassis and the monitor.

power-on diagnostics

A series of tests that automatically checks the hardware components of your system each
time you turn it on.
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power supply

The piece of hardware in the Octane chassis that directs power from an electrical outlet
to the chassis, monitor, and internal SCSI devices.

Printer Manager

A tool that you access through either the System toolchest or the System Manager. Use it
to set up printer software and monitor jobs that you send to the printer.

PROM monitor

The interface that you use to communicate with the system after it is powered on, but
before it is booted and running IRIX.

prompt

A character or word that the system displays in an IRIX shell; it indicates that the system
is ready to accept commands. The default prompt for regular user accounts is %; the
default prompt for the root account is #.

quit

To stop running an application.

reference page

See man (manual) page.

remote workstation, drive, disk, filesystem, or printer

A hardware device, or the information or media it contains, that you can access across
the network; it is not physically connected to your workstation.

reset button

A button on the workstation that you can press, to cut off power to the workstation and
then immediately restores it. Never press this button while IRIX is running unless all
attempts to shut down the system using software fail. See also shut down.

restore (files)

To copy files that once resided on your hard disk from another disk or a tape back onto
your hard disk.
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root account

The standard IRIX login account reserved for use by the system administrator. This
account’s home directory is the root (/) directory of the filesystem; the user of the root
account has full access to the entire filesystem (that is, that user can change and delete
any file or directory). The user of this account is sometimes referred to as the superuser.

root (/) directory

The directory at the top of the filesystem hierarchy.

screen

The portion of the monitor that displays information.

SCSI

Small Computer System Interface (pronounced “scuzzy”). SCSI is a high- speed
input/output specification for small computers. The Octane workstation is SCSI-3
compliant and supports two Ultra fast/wide/single-ended SCSI buses, each capable of
transferring data at 40 MB per second.

SCSI address

A number from one to seven that uniquely identifies a SCSI device to a system. No two
SCSI devices that are physically connected to the same SCSI bus can have the same SCSI
address.

SCSI address dial

A small plastic dial connected to some Silicon Graphics external SCSI devices. Click on
its small buttons to select a SCSI address for a new SCSI device.

SCSI bus length

The combined length of all internal and external SCSI cables in a system for each SCSI
bus.

SCSI cable

A cable that connects a SCSI device to a SCSI port on a workstation.

SCSI device

A hardware device that uses the SCSI protocol to communicate with the system. Hard
disk and floppy disks, CD-ROM drives, and tape drives are all SCSI devices. See also
SCSI.
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SCSI terminator

An electronics device, often an external plug, that is required at the end of each SCSI bus.
The Octane workstation uses active terminators only on an external SCSI or Ultra-SCSI
device, not on the workstation itself.

select

To position the cursor over an icon, then click the left mouse button. Once an icon is
highlighted, it is the object of whatever operation you select from a menu.

serial device

Any hardware device that requires a serial cable connection to communicate with the
workstation.

serial port

An outlet on the workstation to which you connect external serial devices.

server

A system that other systems on the network access to use its disk space, software, or
services.

shell

A window into which you type IRIX commands.

shielded cable

A cable with a protective covering that reduces the possibility of interference with radio,
television, and other devices.

shut down

To safely close all files, log out, and bring the workstation to a state where you can safely
power it down. From the Toolchest > System, choose System Shutdown to do this.

software option

Any software product that you buy from Silicon Graphics other than the standard
operating system software that comes on your system disk.

standalone workstation

A workstation that is not connected to a network.
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static electricity

Whenever your body comes in physical contact with metal parts (including printed
circuit boards) of computer equipment, there is the potential for you to feel an electrical
shock (electrostatic discharge, or ESD), which could damage the equipment. To prevent
this, you must always wear a wrist strap when working with the internal parts of a
workstation.

StereoView

A port on the graphics board to which you attach a cable that attaches to Stereo View (3D)
glasses or a Stereo View (3D) headset.

superuser

A user with root privileges. You become a superuser by logging in as root, by typing su

at the shell prompt, or by running programs set up to run as root. See also system
administrator.

system

All the hardware and software that makes up the workstation.

system administration

The tasks associated with setting up, maintaining, and troubleshooting a networked or
standalone system.

system administrator

The individual responsible for setting up, maintaining, and troubleshooting a system.
The system administrator uses the root login account to perform most administrative
tasks.

system crash

When the IRIX operating system fails and the system does not accept any keyboard or
mouse input.

system disk

The physical disk that contains the standard IRIX operating system software (the
software that makes your workstation run).

System Manager

A set of tools that the administrator uses to set up and manage the Silicon Graphics
workstation. You access the System Manager through the System toolchest.
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system software

The standard IRIX operating system software and Silicon Graphics tools. These come on
the system disk and on the CD that you use in the event of a system crash.

System toolchest

The toolchest in the upper left-hand corner of the screen labeled “System.” You start
system tools, such as System Manager, using this menu.

TCP/IP

A standard networking protocol that is included in the system software.

thumbscrew

The ridged knob attached to a screw in a cable connector. You turn it to secure the
connector to an outlet.

unmount

To make a filesystem that is accessible from a specific directory on your workstation
temporarily inaccessible.

upgrade

Hardware or software that you add to the basic workstation to increase performance,
such as additional memory (DIMMs), a higher capacity CPU, more powerful graphics
boards, and so on.

user ID (UID)

A number that uniquely identifies a user to the system.

Watt (average)

Average power in watts 1Wave=1Vrms x 1Arms. (Watt [average] refers to audio power often
quoted as Watts rms.)

window

A portion of the screen that you can manipulate that contains text or graphics.
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workstation

An assembly of hardware that includes a system board, graphics board, CPU, memory,
system disk, and power supply. A workstation can include multiples of these
components and optional boards that add functionality. The hardware is enclosed in a
chassis with a cover. The addition of a monitor, keyboard, mouse, and software makes it
a working system.

wrist strap

A flat cable that you wrap around your wrist and attach to a metal part of the workstation
whenever you work with internal components of the workstation. This prevents
electrical shocks to yourself and the components. See also static electricity.

XIO boards

High speed-boards produced by Silicon Graphics such as graphics, networking, disk
interface, or video boards. They reside on the XIO module and are directly connected to
the frontplane.
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A

accessing System Maintenance menu,  266, 268
active speaker,  208
adapters and serial cables,  304
addresses for external drives,  187
analog line level specifications,  296, 313
audio

analog line level,  211
coaxial digital,  211
optical digital,  211

audio devices,installing,  204
audio ports,  205

B

backups,  271
back view of workstation,  6
baffle

installing,  164
removing,  153

banks, DIMM,  55
bezel

removing,  219
replacing,  256

blank panel
drive bay, removing,  226
internal drive, installing,  229
PCI module,  119
XIO,  133

blank panel, XIO, installing,  154
button, reset,  270

C

cable guard
installing,  159
removing,  145

cable length
daisy-chaining SCSI devices,  189
SCSI devices,  189

cables
external devices,  189
SCSI, daisy-chaining devices,  193
serial cables,  204
serial cables and adapters,  304
using shielded,  330, 333

cable specifications
PC modem serial cable,  305
printer/dumb terminal serial,  305
serial port adapter cables,  307

cap, compression connector,  47
chassis, lifting,  255
cleaning, DAT or DLT drives,  185
coaxial digital port specifications,  296
color coded DIMMs,  55
combining SCSI devices,  189
compression connector

cap,  47
care and cleaning,  287
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description,  287
handling instructions,  288
PCI module,  89
system module,  46

confidence test,  268
configuring, serial devices,  204
connect, SCSI device,  194
console window,  28
cover, top plastic, removing and replacing,  250
CPU, installing,  51
creating system disk,  317

D

daisy-chaining SCSI devices,  189
DAT drive,  185
Declaration of Conformity,  326
desktop,  25
diagnostic tests,  268
dial and button boxes,  201
digitizer tablets,  201
dimensions of workstation,  311
DIMM

banks,  55
color coding,  55
installing,  58
removing,  57
sockets,  55

disabling system maintenance password,  273
disk capacity,  218
disk drives. See  drives
disks, formatting floppy,  201
DLT drive,  185
documentation,  26
drive addresses, for external drives,  187
drive bays, option,  223

drives
cleaning DAT or DLT,  185
DAT or DLT,  185
installing external,  186
testing new,  234

drives, internal
installing,  217
removing,  217

E

enabling system maintenance password,  275
Ethernet port specifications,  300
Ethernet specifications,  298
external device, setting address,  188
external drives

checking drive address,  187
installing,  186

external floppy drive, formatting,  201
external SCSI devices

additional information,  200
assigning an address,  187
installing,  186
testing installation,  198

F

fan, system
installing,  245
removing,  245

flex cables
installing,  156
removing,  149

floppy or floptical disk drives,  201
floppy or floptical disks, formatting,  201
formatting, external floppy drive,  201
frontplane module
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installing,  237, 244
removing,  237

front view of workstation,  5

G

graphics board
Octane/MXI or MXE,  284
Octane/SI or SE,  281
Octane/SSI or SSE,  283

graphics board screws,  133

H

handling instructions, compression connector,  288
headphone specifications,  313

I

IDE tests,  268
InfoSearch,  27
InSight,  27
Installing

texture memory option board,  166
installing

audio devices,  204
baffle,  164
blank panel, internal drive,  229
cable guard,  159
CPU,  51
external drives,  186
external SCSI devices,  186
flex cables,  156
frontplane module,  237, 244
internal drives,  217
internal option drives,  223
keyboard,  212

light module,  235
lockbar,  257
memory,  58
microphone,  206
mouse,  212
Octane Hardware Central,  4, 27
PCI board,  96
PCI module,  119
plactic base,  252
power supply,  77
serial devices,  201
speakers,  208
system drive,  231
system fan,  245
system module,  59
terminator on SCSI device,  196
XIO blank panel,  154
XIO graphics board,  154
XIO option board,  154

interactive diagnoistic environment test,  268
interference to radios and televisions,  329
internal drive

installing,  223
testing installation,  234
turning on software,  234

internal option drives, removing,  228
I/O blank panel, PCI module,  115
IP address,  4
IRIS InSight Document Library,  27
IRIX Interactive Desktop,  25
IRIX shell,  28

J

jumper, disabling system maintenance password,
274
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K

keyboard, replacing,  212
keyboard specifications,  302

L

label, regulatory,  326
LEDs, lightbar,  261
lifting the chassis,  255
lifting the workstation,  8
lightbar LEDs,  261
light module

installing,  235
removing,  235

lockbar,  21
installing,  257
location,  220
removing,  220

lockbar slot,  21
locking the workstation,  21
logging in,  24
login,  24

M

maintenance menu, system,  269
memory

installing,  58
removing,  57

memory installation, verifying,  66
microphone, installing,  206
microphone specifications,  294, 312
module

front,  217
PCI,  85

system,  42
XIO, replacing,  173

monitor cable, XIO boards,  135
monitor port, specifications,  309
mouse, replacing,  212
mouse port specifications,  302
moving the workstation,  8

N

NMI button,  265
non-maskable interrupt button,  265
notifier, XIO module incorrectly inserted,  173

O

Octane Hardware Central
installing,  4, 27
Netscape access,  3

Octane/MXI or MXE graphics board,  284
Octane/SI or SE graphics board,  281
Octane/SSI or SSE graphics board,  283
opening, PCI module,  94
operating system,  4
optical digital port specifications,  297
option drive bays,  223
option drives, internal, removing,  228

P

parallel port specifications,  301
parts, returning,  278
passive speaker,  208
PCI board

installing,  96
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removing,  109
PCI module,  85

blank panel,  84, 119
information,  85
installing,  119
I/O blank panel,  115
opening,  94
removing,  89
removing cables,  87

PCI slot,  96
PC modem serial cable specificications,  305
peripherals, serial devices,  201
physical environment specifications,  311
plastic base, removing and installing,  252
power cables, SCSI devices,  198
powering off,  38
powering on,  20
power off

system does not power off,  277
toolchest,  32

power-on diagnostic test,  268
power requirements,  311
power specifications,  311
power supply

installing,  77
removing,  73

printer/dumb terminal serial cable specifications,
305

processor, installing,  51
product support,  xxii

R

radio interference,  329
recovering from system crash,  269
regulatory label,  326
removing

baffle,  153
bezel,  219
blank panel from drive bay,  226
cable guard,  145
flex cables,  149
frontplane module,  237
internal drives,  217
internal option drives,  228
light module,  235
lockbar,  220
memory,  56
PCI board,  109
PCI module,  89
plastic base,  252
power supply,  73
system fan,  245
system module,  42
texture memory option board,  170
XIO graphics board, option board, blank panel,

142
XIO module,  137

removing and installing, top plastic cover,  250
replacing

bezel,  256
keyboard,  212
light module,  235
mouse,  212
plastic base,  252
system drive,  231

reset button,  270
returning parts,  278

S

screws for XIO graphics boards,  133
SCSI, address for drives,  187
SCSI address

assigning to external device,  187
setting on external device,  188
357



Index
SCSI addresses, assigning,  185
SCSI bus speed,  193
SCSI cables,  189
SCSI device, external, assinging an address,  187
SCSI devices

cables, daisy-chaining,  193
combining,  189
connecting,  194
daisy-chaining,  189
installing external,  186
terminator,  191

SCSI devices daisy-chained, speed,  193
SCSI port specifications,  298
serial

cables,  204
installing devices,  201

serial cables and adapters, specifications,  304
serial devices

configuring,  204
installing,  201

serial number,  4
serial port adapter cables specifications,  307
serial ports specifications,  303
set up workstation,  10
shielded cables,  330, 333
shipment components,  7
shut down, toolchest,  32
shut down and power off, power button,  29
sockets, DIMM,  55
software

internal drives,  234
serial devices,  204

speaker
active,  208
passive,  208

speaker port specifications,  295
speakers, installing,  208

speaker specifications,  313
specifications

analog line level,  313
analog line level port,  296
coaxial digital port,  296
Ethernet,  300
headphone,  313
keyboard port,  302
microphone,  312
monitor port,  309
mouse port,  302
optical digital port,  297
parallel port,  301
physical environment,  311
power,  311
printer/dumb terminal serial cable,  305
SCSI port,  298
serial cables and adapters,  304
serial port adapter cables,  307
serial ports,  303
speaker,  313
speaker port,  295
speaker power port,  295
StereoView port,  310

StereoView port specifications,  310
system crash, recovering,  269
system disk, creating,  317
system does not power off,  277
system drive, replacing,  231
system fan

installing,  245
removing,  245

system identification module
installing,  237
removing,  237

system maintenance menu,  268
System Maintenance Menu, accessing,  266
system maintenance password

disabling,  273
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enabling,  275
system module

exterior,  42
removing,  42
replacing,  59

T

Technical Publications Library,  28
technical specifications,  293
television interference,  329
terminator

installing on SCSI device,  196
SCSI device,  191

testing installation
external SCSI device,  198
internal drive,  234

tests
confidence,  268
diagnostic,  268
IDE,  268
power on diagnostic,  268

texture memory option board
installing,  166
removing,  170

toolchest,  26
top cover, plastic, installing,  250
top plastic cover, removing and installing,  250

W

workstation
altitude,  311
ambient temperature,  311
back view,  6
dimensions,  311
front view,  5
lifting,  255
locking,  21

powering off,  38
power requirements,  311
relative humidity,  311
set up,  10
shut down and power off from power button,  29
vibration,  311
voltage and frequency,  311

workstations, radio and television interference
caused by,  329

wrist strap, attaching,  41

X

XIO blank panel
installing,  154

XIO blank panel, removing,  142
XIO blank panels,  133
XIO board

Octane/MXI or MXE graphics,  284
Octane/SSI or SSE,  283

XIO graphics board, installing,  154
XIO graphics board, removing,  142
XIO module,  132

installing,  173
removing,  137
replacing,  173

XIO option board,  133
installing,  154
removing,  142

XIO slot identification,  133
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